The LyX User’s Guide

by the LyX Team*

July 17, 2006

*If you have comments or error corrections, please send them to the LyX Documentation mailing list: lyx-docs@lists.lyx.org
# Contents

1 Introduction

1.1 What is LyX? ................................................................. 1
1.2 Getting Started ............................................................ 1
  1.2.1 Invoking LyX ............................................................ 1
  1.2.2 How LyX Looks .......................................................... 1
  1.2.3 HELP! .................................................................. 2
1.3 The LyX Interface .......................................................... 3
  1.3.1 Basic File Operations ...................................................... 3
  1.3.2 Basic Editing Features .................................................... 4
  1.3.3 Undo and Redo ............................................................. 4
  1.3.4 Basic Mouse Bindings ..................................................... 5
  1.3.5 Basic Key Bindings ......................................................... 5
1.4 Using LyX with Other Programs ........................................ 7
  1.4.1 Importing ASCII files ..................................................... 7
  1.4.2 Cut and Paste Between LyX and Other X Programs ............. 7

2 LyX Setup and Supporting Applications ............................... 9
2.1 Introduction .................................................................... 9
2.2 Basic LyX Setup .............................................................. 9
2.3 Setting Up the X Keyboard [obsolescent] ................................ 10
  2.3.1 xmodmap and xkeycaps ................................................... 10
    2.3.1.1 xmodmap ............................................................. 10
    2.3.1.2 xkeycaps ............................................................ 10
  2.3.2 Modifiers and Mode_switch ............................................ 11
  2.3.3 Helpful Hints and Tips .................................................. 11
2.4 \LaTeX{} ........................................................................ 12
2.5 Dvips and Ghostscript ..................................................... 12
  2.5.1 What You Need ............................................................ 12
  2.5.2 Dvips ......................................................................... 13
  2.5.3 Ghostscript, Xdv and Ghostview ..................................... 14
2.6 The Printer .................................................................... 14

3 LyX Basics .................................................................... 17
3.1 Document Types .............................................................. 17
  3.1.1 Introduction ................................................................. 17
  3.1.2 The Various Document Classes ....................................... 17
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.2.1</td>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>3.1.2.2</td>
<td>Selecting a Class</td>
<td>18</td>
</tr>
<tr>
<td>3.1.2.3</td>
<td>Properties</td>
<td>18</td>
</tr>
<tr>
<td>3.1.3</td>
<td>Fine-tuning the Defaults</td>
<td>19</td>
</tr>
<tr>
<td>3.1.4</td>
<td>Paper Size, Orientation, and Margins</td>
<td>20</td>
</tr>
<tr>
<td>3.1.5</td>
<td>Important Note:</td>
<td>21</td>
</tr>
<tr>
<td>3.2</td>
<td>Paragraph Indentation and Separation</td>
<td>21</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Introduction</td>
<td>21</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Global Indentation Method</td>
<td>22</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Fine-Tuning</td>
<td>22</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Changing Line Spacing</td>
<td>22</td>
</tr>
<tr>
<td>3.3</td>
<td>Paragraph Environments</td>
<td>22</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Overview</td>
<td>22</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Standard</td>
<td>23</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Document Titles</td>
<td>23</td>
</tr>
<tr>
<td>3.3.4</td>
<td>Headings</td>
<td>24</td>
</tr>
<tr>
<td>3.3.4.1</td>
<td>Numbered Headings</td>
<td>24</td>
</tr>
<tr>
<td>3.3.4.2</td>
<td>Unnumbered Headings</td>
<td>25</td>
</tr>
<tr>
<td>3.3.4.3</td>
<td>Changing the Numbering</td>
<td>25</td>
</tr>
<tr>
<td>3.3.4.4</td>
<td>Special Information</td>
<td>26</td>
</tr>
<tr>
<td>3.3.4.5</td>
<td>Creating an Appendix</td>
<td>26</td>
</tr>
<tr>
<td>3.3.5</td>
<td>Quotes and Poetry</td>
<td>26</td>
</tr>
<tr>
<td>3.3.5.1</td>
<td>Quote and Quotation</td>
<td>27</td>
</tr>
<tr>
<td>3.3.5.2</td>
<td>Verse</td>
<td>27</td>
</tr>
<tr>
<td>3.3.6</td>
<td>Lists</td>
<td>28</td>
</tr>
<tr>
<td>3.3.6.1</td>
<td>General Features</td>
<td>28</td>
</tr>
<tr>
<td>3.3.6.2</td>
<td>Itemize</td>
<td>28</td>
</tr>
<tr>
<td>3.3.6.3</td>
<td>Enumerate</td>
<td>29</td>
</tr>
<tr>
<td>3.3.6.4</td>
<td>Description</td>
<td>30</td>
</tr>
<tr>
<td>3.3.6.5</td>
<td>The LyX List</td>
<td>31</td>
</tr>
<tr>
<td>3.3.7</td>
<td>Letters</td>
<td>32</td>
</tr>
<tr>
<td>3.3.7.1</td>
<td>Address and Right Address: An Overview</td>
<td>32</td>
</tr>
<tr>
<td>3.3.7.2</td>
<td>Usage</td>
<td>32</td>
</tr>
<tr>
<td>3.3.8</td>
<td>Academic Writing</td>
<td>33</td>
</tr>
<tr>
<td>3.3.8.1</td>
<td>Abstract</td>
<td>33</td>
</tr>
<tr>
<td>3.3.8.2</td>
<td>Bibliography</td>
<td>34</td>
</tr>
<tr>
<td>3.3.9</td>
<td>Special Purpose</td>
<td>34</td>
</tr>
<tr>
<td>3.3.9.1</td>
<td>Caption</td>
<td>34</td>
</tr>
<tr>
<td>3.3.9.2</td>
<td>LyX-Code</td>
<td>35</td>
</tr>
<tr>
<td>3.4</td>
<td>Nesting Environments</td>
<td>36</td>
</tr>
<tr>
<td>3.4.1</td>
<td>The Big Deal</td>
<td>36</td>
</tr>
<tr>
<td>3.4.2</td>
<td>What You Can and Can’t Nest</td>
<td>37</td>
</tr>
<tr>
<td>3.4.3</td>
<td>Nesting Other Things: Tables, Math, Floats, etc.</td>
<td>38</td>
</tr>
<tr>
<td>3.4.4</td>
<td>Usage and General Features</td>
<td>40</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>3.4.5 Some Examples</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>3.4.5.1 Example #1: The Six-fold Way and Mixed Nesting</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>3.4.5.2 Example #2: Inheritance</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>3.4.5.3 Example #3: Labels, Levels and other list environments</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>3.4.5.4 Example #4: Going Bonkers</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>3.5 Fonts and Text Styles</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>3.5.1 Overview</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>3.5.2 Global Options</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>3.5.3 Using Different Character Styles</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>3.5.4 Fine-Tuning with the Character Layout dialog</td>
<td>46</td>
<td></td>
</tr>
<tr>
<td>3.6 Printing and Previewing</td>
<td>49</td>
<td></td>
</tr>
<tr>
<td>3.6.1 Overview</td>
<td>49</td>
<td></td>
</tr>
<tr>
<td>3.6.2 Quick Viewing with xdvi</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>3.6.3 Viewing the PostScript Version with ghostview</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>3.6.4 Printing the File</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>3.7 A Few Words about Typography</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>3.7.1 Hyphens and Hyphenation</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>3.7.2 Punctuation Marks</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>3.7.2.1 Abbreviations and End of Sentence</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>3.7.2.2 Quotes</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>3.7.3 Ligatures</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>3.7.4 Widows and Orphans</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>4 Tables, Figures, and Notes</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>4.1 Footnotes</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>4.2 Margin Notes</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>4.3 Figures and Imported Graphics</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>4.3.1 How it works</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>4.3.2 Figure Floats</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>4.3.2.1 Using Figure Floats</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>4.3.2.2 Float Placement</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>4.3.3 XFig and LyX</td>
<td>63</td>
<td></td>
</tr>
<tr>
<td>4.4 Tables</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>4.4.1 The Table dialog</td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>4.4.2 What can be placed inside a table cell?</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>4.4.3 Cut &amp; Paste in Tables</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>4.4.4 Multiple lines in cells</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>4.4.5 Table Floats</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>4.5 Table of Contents and other Listings</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>4.5.1 The Table of Contents</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>4.5.2 List of Figures, Tables and Algorithms</td>
<td>69</td>
<td></td>
</tr>
</tbody>
</table>
## 5 Mathematical Formulae

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Basic Math Editing</td>
<td>71</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Navigating a Formula</td>
<td>71</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Selecting Text</td>
<td>72</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Exponents and Subscripts</td>
<td>72</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Fractions</td>
<td>72</td>
</tr>
<tr>
<td>5.1.5</td>
<td>Sums and Integrals</td>
<td>72</td>
</tr>
<tr>
<td>5.1.6</td>
<td>The Math Panel</td>
<td>73</td>
</tr>
<tr>
<td>5.1.7</td>
<td>Other Math Symbols</td>
<td>73</td>
</tr>
<tr>
<td>5.1.8</td>
<td>Altering spacing</td>
<td>73</td>
</tr>
<tr>
<td>5.1.9</td>
<td>Math functions</td>
<td>74</td>
</tr>
<tr>
<td>5.1.10</td>
<td>Accents</td>
<td>74</td>
</tr>
<tr>
<td>5.1.11</td>
<td>The math editor for \LaTeX\ users</td>
<td>75</td>
</tr>
<tr>
<td>5.2</td>
<td>Brackets and decorations</td>
<td>76</td>
</tr>
<tr>
<td>5.3</td>
<td>Grouping</td>
<td>76</td>
</tr>
<tr>
<td>5.4</td>
<td>Arrays and Multi-line Equations</td>
<td>77</td>
</tr>
<tr>
<td>5.5</td>
<td>Equation Numbering and Labels</td>
<td>78</td>
</tr>
<tr>
<td>5.6</td>
<td>User defined macros in math mode</td>
<td>79</td>
</tr>
<tr>
<td>5.6.1</td>
<td>How to create macros</td>
<td>79</td>
</tr>
<tr>
<td>5.6.2</td>
<td>How to navigate in macros</td>
<td>80</td>
</tr>
<tr>
<td>5.7</td>
<td>Fine-Tuning</td>
<td>80</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Typefaces</td>
<td>80</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Math Text Mode</td>
<td>81</td>
</tr>
<tr>
<td>5.7.3</td>
<td>Font Sizes</td>
<td>81</td>
</tr>
<tr>
<td>5.8</td>
<td>AMS-\LaTeX\</td>
<td>82</td>
</tr>
<tr>
<td>5.8.1</td>
<td>Enabling AMS-Support</td>
<td>82</td>
</tr>
<tr>
<td>5.8.2</td>
<td>AMS-Symbols</td>
<td>82</td>
</tr>
<tr>
<td>5.8.3</td>
<td>AMS-Formula Types</td>
<td>82</td>
</tr>
</tbody>
</table>

## 6 More Tools

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Cross-References</td>
<td>83</td>
</tr>
<tr>
<td>6.2</td>
<td>URLs (Uniform Resource Locators)</td>
<td>84</td>
</tr>
<tr>
<td>6.3</td>
<td>Short Titles</td>
<td>84</td>
</tr>
<tr>
<td>6.4</td>
<td>Branches</td>
<td>85</td>
</tr>
<tr>
<td>6.5</td>
<td>Previewing snippets of your document</td>
<td>85</td>
</tr>
<tr>
<td>6.6</td>
<td>Spacing, pagination and line breaks</td>
<td>86</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Extra Horizontal Space</td>
<td>86</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Extra Vertical Space</td>
<td>86</td>
</tr>
<tr>
<td>6.6.3</td>
<td>Changing Paragraph Alignment</td>
<td>87</td>
</tr>
<tr>
<td>6.6.4</td>
<td>Forcing Page Breaks</td>
<td>87</td>
</tr>
<tr>
<td>6.6.5</td>
<td>Blanks/Spaces</td>
<td>88</td>
</tr>
<tr>
<td>6.6.5.1</td>
<td>Inter-word Space</td>
<td>88</td>
</tr>
<tr>
<td>6.6.5.2</td>
<td>Protected Space</td>
<td>88</td>
</tr>
<tr>
<td>6.6.5.3</td>
<td>Thin Space</td>
<td>88</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 What is LyX?

LyX is a document preparation system. It is a tool for producing beautiful manuscripts, publishable books, business letters and proposals, and even poetry. It is unlike most other “word processors” in the sense that it uses the paradigm of a markup language as its core editing style. That means that when you type a section header, you mark it as a “Section”, not “Bold, 17 pt type, left justified, 5 mm space below”. LyX takes care of the typesetting for you, so you deal only with concepts, not the mechanics.

This philosophy is explained in much greater detail in the “Introduction”. If you haven’t read it yet, you need to. Yes, we mean now.

The “Introduction” describes several things in addition to LyX’s philosophy: most importantly, the format of all of the manuals. If you don’t read it, you’ll have a bear of a time navigating this manual. You might also be better served looking in one of the other manuals instead of this one. “Introduction” describes that, too.

1.2 Getting Started

1.2.1 Invoking LyX

Similar to other Linux [and other brands of Unix] programs, you start LyX by simply typing `lyx` at the command line. You can, of course, include several command-line options, including file names. We’re not going to repeat all of the command-line options here, since we’ve already done that in the `man` page for LyX. Check there for more info.

There are one or two things we’d like to comment on:

Please note that if you include more than one file name on the command line, LyX will load them all, though it won’t display them all simultaneously. More on that in a bit.

1.2.2 How LyX Looks

Like most applications, LyX has the familiar menu bar across the top of its window. Below it is a toolbar with a pulldown box and various buttons. There is, of course, a vertical scrollbar and a main work area for editing documents. Near the bottom of the window is a small window containing a single line of text. This is the `minibuffer` (a term which we’ve swiped, lock, stock, and barrel, from GNU Emacs), which really
means “command buffer”. Type M-x when you need to type a command in the minibuffer.

Note that there is no horizontal scroll bar. This is not a bug or an oversight, but intentional. When you read a book, you expect the end of a line to wrap around to the next line. Text overflows onto new pages in a vertical fashion, hence the need for only a vertical scrollbar.

There are three cases where you might want a horizontal scrollbar. The first case is large figures, displayed WYSIWYG. This, however, is due to a flaw in the routine that displays graphics on the L\LaTeX\ screen in a WYSIWYG fashion; it should rescale the graphics to fit in the window, just as you’d need to rescale graphics to fit on a page. The second and third cases are tables and equations which are wider than the L\LaTeX\ window. You can use the arrow keys to scroll horizontally through the table, but this doesn’t work for equations yet.

\subsection{HELP!}

First, the bad news: the help system is not as thorough as that in many commercial applications. Patience. We’re working on it.

Now the good news: the help system consists of the L\LaTeX\ manuals. You can read all of the manuals from inside L\LaTeX. Just select the manual you want read from the Help menu.

While we’re at it, we’d like to make a comment about the manuals. They’re not idiot-proof, not in the least. Here’s what one of our authors, JOHN WEISS, once said about manuals:

I hate manuals.

Yes, we’ve all dealt with the terse, poorly-translated, or cryptic manuals. They are aggravating. I find, however, that the overly simplified ones are even more aggravating. First, they spend about half their time carefully explaining to the user how to operate a mouse, what a menu is, et cetera, ad nauseum. Please, if someone doesn’t know how to use their own computer, or a GUI, then they should sit down and learn before they start up a major piece of software.

Second, what information they do provide seems to assume that the user is stupid. Utter nonsense! Most users, in my experience, are some combination of clueless and intimidated, not stupid. Besides, if someone is truly slow on the uptake, they need help that a manual for a piece of computer software can’t give.

Editor’s Note: With this in mind, I’ve instructed all of the other authors to avoid patronizing you, the reader, and to be more pedagogical than pedantic. As for those who are too lazy to read and understand the manuals — well, as we say here in America, there’s no such thing as a free lunch. - jw
1.3 The LyX Interface

1.3.1 Basic File Operations

Under the File menu are the 9 basic operations for any word processor in addition to some more advanced operations:

- New
- New from Template
- Open
- Close
- Save
- Save As
- Revert
- Print
- Exit

They all do pretty much the same thing as in other word processors, with a few minor differences. The File►New from Template command not only prompts you for a name for the new file, but also prompts you for a template to use. Selecting a template will automatically set certain layout features for the document, features you would otherwise need to change manually. They can be of use for certain classes, especially those for writing letters [see sec. 3.1.2]

Note: There is no “default file” or document named “Untitled” or “scratch.” Unless you tell LyX to open a file or create a new one, that big, blank space is just that — a big, blank space.

The Revert command is useful if more people work on the same document at the same time. It will simply reload the document from disk. You can of course also use it if you regret that you changed a document and want to restore it to the last save.

The second matter of note concerns the commands File►Close and File►Exit. They both feature a “nag box” to save us all from our own stupidity. That is, if you try to close a file with changes [or exit LyX], you’ll be informed that there are unsaved files.

\[^{1}\text{If you plan to do this, you should check out the Version Control feature in LyX also. Read Extended Features.}\]
1.3.2 Basic Editing Features

Like most modern word processors, LyX can perform cut and paste operations on blocks of text, can move by character, word, or screenful of text, and can delete whole words as well as individual characters. The next four sections cover the basic LyX editing features and how to access them. We'll start with cut and paste.

As you might expect, the Edit menu has the cut and paste commands, along with various other editing features. Some of these are special and covered in later sections. The basic ones are:

- Cut
- Copy
- Paste
- Find & Replace...

The first three are self-explanatory. One thing to note: whenever you delete a block of text that you’ve selected, it’s automatically placed in the clipboard. That is, the Delete and Backspace keys also functions as the Cut command. Also, if you’ve selected text, be careful. If you hit a key, LyX will completely delete the selected text and replace it with what you just typed. You’ll have to do an Undo to get back the lost text.

The Edit▶Find & Replace… item opens the Find & Replace dialog. The text you want to find goes in the Find box. Once you’ve found a word or expression, LyX selects it. Hitting the Replace button replaces the selected text with the contents of the Replace with box. You can click to search again to skip the current word.

Hit Replace All to replace all occurrences of the text in the document automatically.

The Case sensitive toggle button can be used if you want the search to consider the case of the search word. If the toggle is set, searching for “Match” will not match the word “match”.

The Match Word toggle button can be used to force LyX to only find complete words. I.e., searching for “match” will not match “matches”, “matchbox”, etc.

1.3.3 Undo and Redo

If you make a mistake, you can easily recover from it. LyX has a large-capacity undo/redo buffer. Select Edit▶Undo to undo some mistake. If you accidently undo too much, use Edit▶Redo to “undo the undo.” The undo mechanism is currently limited to 100 steps to minimise memory overhead.

Notice that if you revert back all changes to arrive to the document as it was last saved, the “changed” status of the document is unfortunately not reset. This is a consequence of the 100 step undo limit, above.

The Undo and Redo work on almost everything in LyX. They have some quirks, too. They won’t Undo or Redo text character by character, but by blocks of text.
1.3 The \textit{LyX} Interface

That can take some getting used to; you’ll have to play with \textit{Undo} and \textit{Redo} to get a feel for just how much they’ll undo/redo, and after time, you’ll hopefully appreciate how it works.

1.3.4 Basic Mouse Bindings

We’re not going to go into all of the mouse bindings here. Some of the other sections of this manual cover specific operations you can do with the mouse. Instead, we’re going to cover the most basic mouse operations.

1. Motion

   - Click the \textit{left mouse button} once anywhere in the edit window. The cursor moves to the text under the mouse.

2. Selecting Text

   - Hold down the \textit{left mouse button} and drag the mouse. \textit{LyX} marks the text between the old and new mouse positions. Use \textit{Edit} $\triangleright$ \textit{Copy} to create a copy of the text in \textit{LyX}’s buffer.
   - Re-position the cursor and then paste the text back into \textit{LyX} using \textit{Edit} $\triangleright$ \textit{Paste}.

3. Footnotes, Margin Notes, Figure and Table Floats, etc.

   \textit{Single click} the left mouse button to open or close any of these. Also check the appropriate section of this manual for more details.

4. Tables

   \textit{Single click} the right mouse button to open a dialog that will allow you to manipulate the table.

1.3.5 Basic Key Bindings

Again, we’re not going to cover all of the keybindings. Be aware that there are at least two different primary binding maps: CUA and Emacs. I guarantee you will cuss when you press Control-d to delete a character, and it starts up a DVI previewer instead (or vice versa).


\textbf{Tab} There is no such thing as a tab stop in \textit{LyX}. If you don’t understand this, go read Sections 3.2.1 and 3.3, especially Section 3.3.6, right now. Yes, right now. If you’re still confused, look in the \textit{Tutorial}. 
1 Introduction

Esc This is the “cancel key.” It’s used, generically, to cancel operations. Other parts of the manual will go into greater detail about this.

Home and End These move the cursor, respectively, to the beginning and end of a line, unless you are using the Emacs bindings where they jump to the beginning or end of the file.

Backspace and Delete If you have your keyboard set up correctly under the X Windows System, Backspace works as expected and Delete deletes the character under the cursor [if no text is selected].

If you haven’t set up your keyboard under X, or have no idea what we mean by that, go read section 2.3 immediately. You’ll save yourself a lot of headaches.

Then there are the modifier keys:

Control- This has a couple of different uses, depending on which keys it’s used in combination with:

- With Backspace or Delete, it deletes an entire word instead of a single character.
- With Left and Right, it moves by words instead of characters.
- With Home and End, it moves to the beginning and the end of the document, respectively.

Shift- Use this with any of the motion keys to select the text between the old and new cursor positions.

Meta- This is the Alt key on many keyboards, unless your keyboard has a distinct Meta key. Unfortunately, X sometimes has their functionality swapped, so if you have both keys, you will need to do a little trial and error to find out which one actually performs the Meta- function. This key does many different things, but it also activates the menu accelerator keys. If you use this in combination with any of the underlined letters in a menu or menu item, it selects that menu item.

For example, the sequence “M-e s” brings up the “Text Style” menu. Typing “M-f” opens the File menu.

There are also other things bound to the Meta- key, but you’ll have to check in the Reference manual for more info.

Hopefully, you’ll learn more and more keybindings and short-cut keys as you use LyX, because most mouse actions will prompt a small message in the minibuffer which describe the name of the action, you’ve just triggered, and any existing keybindings for that action. The notation for the keybindings is very similar to the notation
1.4 Using \texttt{LyX} with Other Programs

1.4.1 Importing ASCII files

You can import text from an ASCII file using the \texttt{File} $\Rightarrow$ \texttt{Import} $\Rightarrow$ \texttt{Ascii text as lines} or \texttt{File} $\Rightarrow$ \texttt{Import} $\Rightarrow$ \texttt{Ascii text as paragraphs} options.

\texttt{File} $\Rightarrow$ \texttt{Import} $\Rightarrow$ \texttt{Ascii text as lines} puts each line of the file into its own \texttt{LyX} paragraph. This is useful if you’re importing a text file with a simple list in it. However, if your text file contains paragraphs in it, \texttt{LyX} will mangle the paragraphs if you use this form of import.

\texttt{File} $\Rightarrow$ \texttt{Import} $\Rightarrow$ \texttt{Ascii text as paragraphs} preserves paragraphs in text files. Often in a text file, you didn’t put the contents of an entire paragraph on one line. You used Return to break up the paragraph into separate lines. Using the as paragraphs, \texttt{LyX} won’t mangle such paragraphs. Anything between two consecutive blank lines goes into its own \texttt{LyX} paragraph. Remember: you must make sure there is a \textit{completely blank} line between each and every paragraph in your text file. If not, \texttt{LyX} might end up merging two paragraphs.

1.4.2 Cut and Paste Between \texttt{LyX} and Other X Programs

The \texttt{Cut}, \texttt{Copy}, and \texttt{Paste} operations will transfer text to and from \texttt{LyX}. You can copy text from \texttt{LyX} to another window in this way: Select the text that you want to copy, then go to the destination window and paste the text with the middle mouse button.

Pasting text into \texttt{LyX} also works much the same way as in X. Select the text with the mouse in another X window. Go to the Lyx window and paste the text with the middle mouse button.
1 Introduction
2 **LyX Setup and Supporting Applications**

2.1 **Introduction**

If you’re using LyX on a system someone else has set up for you, then you can safely skip this chapter. It describes all of the things you need beyond the LyX binary and files distributed with it.

If you’re installing LyX on your system, *you should read the README’s that came with the LyX distribution and then Help→LaTeX Configuration*. Do that first. This chapter does not describe installation or setup of the LyX binary *[Well, not everything...]*. It does describe all of the things you’ll need to use LyX to its fullest.\(^1\)

2.2 **Basic LyX Setup**

There are two ways to run LyX. The first way is to install LyX and all of its support files on your system. Of course, you need root (administrator) privileges to do that.

The second way to run LyX doesn’t require root access, letting you “install” LyX somewhere in your own account. LyX will automatically detect where it is as long as the supporting directories are put in the correct places.

There are several features of LyX that can be configured from inside LyX, without resorting to configuration files. First, LyX is able to inspect your system to see what programs, \LaTeX{} document classes and \LaTeX{} packages are available. It uses this knowledge to give reasonable defaults to several preferences variables. Although this configuration has already been done when LyX was installed on your system, you might have some items that you installed locally and which are not seen by LyX. To force LyX to re-inspect your system, you should use **Tools→Reconfigure**. You should then restart LyX to ensure that the changes are taken into account. As far as \LaTeX{} classes and packages are concerned, you will find information about what has been found under **Help→LaTeX Configuration**.

The second set of settings that you might want to change comprises all the document-level setting that you can change via the **Document→Settings** dialog. To do this, open a scrap document, set all these options according to your taste and save them with the **Save as Document Defaults** button in the **Document** dialog. This will create a

---

\(^1\)This is basically where we decided to document a bunch of info about running LyX, including what other programs you’ll need to make LyX useful.
2 L\textsc{y}X Setup and Supporting Applications

template named \texttt{default.lyx} which is automatically loaded by \textsc{lyx} when you open a document without template such that the settings are automatically set-up as you defined them.

There are many other user-configurable options that you can feed to \textsc{lyx}. Upon startup, \textsc{lyx} reads a global options file called \texttt{lyxrc.defaults}. It will then attempt to read a file called \texttt{preferences\textsuperscript{2}}

The Tools$\ddagger$Preferences dialog can be used to change these options; the document \textit{Customization} contains more information about the preferences dialog and these configuration files.

2.3 Setting Up the X Keyboard [obsolescent]

To use \textsc{lyx} properly, X \textit{must} be set up correctly. This is especially vital if you’re using the international support features of \textsc{lyx} and want to use non-English keyboard mappings. On modern distributions, this likely has been taken care of, but if not, you must do this yourself. Administrators of large systems often neglect this, so don’t assume that you’re safe if you’re using a large system. Also ordinary users can instruct X how to use his or her keyboard.

2.3.1 xmodmap and xkeycaps

First of all read the man pages for these two programs. They are your best friends when you are trying to set up X key mapping correctly. If you don’t have them, install them.

2.3.1.1 xmodmap

This document contains no information on how to use \texttt{xmodmap}. There is a sample \texttt{.Xmodmap} file in \textit{Customization}. To load the new X keyboard mappings, place the command \texttt{xmodmap .Xmodmap} somewhere in your startup scripts [e.g. \texttt{.cshrc}, \texttt{.profile}, \texttt{.login} or \texttt{.xinitrc} are possible].

2.3.1.2 xkeycaps

This program brings up a graphical version of your keyboard, allows you to make modifications, and then spits those modifications out to the standard output in a form readable by \texttt{xmodmap}. It is very useful when you’re trying to design a new \texttt{.Xmodmap} file, though it will require you to do a bit of cut-and-pasting.

\textsuperscript{2}The \texttt{preferences} file is found in different directories on different systems. This directory is called \textsc{lyx}’s user directory. To find out where it is, use Help$\ddagger$About \textsc{lyx}. (You may set up an alternative user directory from the command line, using the switch \texttt{-userdir}.)
2.3 Setting Up the X Keyboard [obsolescent]

2.3.2 Modifiers and Mode_switch

LyX supports three modifiers: Shift [S-], Control [C-], and Meta [M-]. Moreover, if one of the keys of your keyboard is configured as a Compose key, then you can use it to enter some characters not available on your keyboard. This compose key can be used either as a modifier (like Shift or Control) or as a prefix key. Here are some examples of what you can do with a Compose key:

- Compose+e+’ → é
- Compose+O+R → ®
- Compose+1+2 → ½
- Compose+<+< → «

This input method is particularly handy when you use accented characters only from time to time. It works by default for latin1 characters, but other input methods will be used if you setup your locale correctly.

2.3.3 Helpful Hints and Tips

First, open up two xterminals. Use one to edit a new .Xmodmap file and run xkeycaps from the other. Using xkeycaps, remap your keyboard the way you want it. There’s a button in xkeycaps to output the new keymap. Once you hit it, xkeycaps will spit a bunch of stuff on the xterm you executed it from. Just copy and paste all of that into your .Xmodmap file, and you’re done.³

Also, there are some things you can do to help you get oriented. Try executing the command xmodmap -v -pm. This will show you all of the currently active modifiers. Also try xmodmap -v -pke | more to see which keycode numbers are mapped to which symbolic names. It will also give you some idea of the syntax of the .Xmodmap file.

There’s one thing you’ll need to check. Make sure that your Delete and BackSpace keys are not defined as the same key symbol by X! Note that giving these two keys unique symbol names will not necessarily alter the behavior of your programs. Some programs bind Delete and BackSpace to the same operation. Emacs is one. Other programs, however, use Delete and BackSpace for different operations. LyX is one of these programs, and if you have Delete and BackSpace labeled with the same key symbol name, you’ll have trouble using LyX.

³You could also save yourself some typing by executing xkeycaps > .Xmodmap. This will create a usable map file.
2.4 LATEX

If you want to do more with LyX than simply create documents and spit out .tex files, you’ll need LATEX.

In case you were wondering, LATEX is a markup language front end for TEX, a document preparation system invented in 1984 by Donald Knuth.\textsuperscript{4} TEX takes a set of commands in an ASCII file and converts it to a “device-independent” format, or Dvi, for short. The Dvi file can then be sent to printers. TEX is programmable, and LATEX is nothing but a [really huge] set of TEX macros. LATEX will typically come as part of a TEPX distribution, so all you need is a TEPX package.

Note that on some old systems you may find that only LATEX 2.09 is installed (as opposed to the more current LATEX 2\varepsilon). LyX cannot be used with LATEX 2.09.

If you’re using Linux, LATEX 2\varepsilon should have come with your distribution. For other systems, you might need to install LATEX yourself. You can obtain a LATEX distribution (and anything and everything related to TEX and LATEX) from a Comprehensive TEPX Archive Network (CTAN) mirror. A complete list of mirrors may be found at http://www.ctan.org

2.5 Dvips and Ghostscript

2.5.1 What You Need

There’s one more step you need to take if you want to print your LyX documents. Obviously, you’ll need to make sure your printer is configured [see next section]. You’ll also need to install these programs (or compatibles), if you don’t have them already:

- dvips
- ghostscript
- xdvi
- ghostview

The latter two programs are previewer for files in Dvi and PostScript\textsuperscript{5} format. If you don’t know what a DVI file is, you’ve probably also never worked with LATEX and should read the Tutorial document before proceeding further. dvips converts DVI files into PostScript, which is the format most printers use nowadays. For those of you using dot-matrix and inkjet printers, you’ll want to filter the PostScript through ghostscript, which is capable of creating output for a variety of printers. The

\textsuperscript{4} A note about pronunciation: TEX originated from the Greek letters, τχ, which rhymes with “blech.” That’s how you pronounce “TEX” and “LTEX.” [If you're American, just pronounce the “X” as a “k” and you’ve got it.]

\textsuperscript{5} PostScript is a registered trademark of Adobe Systems Incorporated, and is the main page description language in the UN*X world.
following section on printer setup describes how to do this automatically every time you print. For now, we’ll concentrate on dvips.

### 2.5.2 Dvips

Whether you’ll be running LyX on a large system or a Linux box at home, you should configure dvips. dvips will either “print” into a file, or send output directly to the printer, depending on how it’s configured. If it is set up to print to a file, and if no filename is specified, it will simply turn foo.dvi into foo.ps. Most systems have dvips set up to send output to the default printer. For LyX, you’ll want the flexibility to do both.

If you are not a mood to configure dvips to adapt its output to your printer, you can safely skip this section. Be warned however that the output will not match the quality that you could expect from your printer. At least, it will print.

If you are using TeX (a TEX distribution which is particularly popular on Linux), you should run the program texconfig. To make the name of a new printer recognized by dvips you should then select menu entry Dvips, then add. Enter the required parameters and, before exiting, remember to select the function Rehash.

Let’s turn now to manual configuration: in order to inform dvips how to automatically convert a .dvi file into a .ps file adapted to printer foo, you need to have a config-file, “config.foo,” lying around somewhere. Typically, the config.* files for dvips will be in /usr/lib/texmf/dvips in most TeX distributions. Your system will probably be different, of course, so just look under the main TeX directory for a subdirectory called “dvips.” It’ll be there somewhere.

Typically, there will be at least one config-file: config.ps. This file is the default configuration file, which is always read by dvips. Read this file and see what options could need to be changed for your particular printer. Then create a file config.foo containing only the relevant lines.

There’s at least one thing you need to do to the config-file. There may exist a line that looks like, “o | lpr” [without the quotes, of course...]. Change it to “o | lpr -Pfoo”, so that the output is sent by default to printer foo. However, you should probably investigate the entries “M” and “D”, which define respectively the Metafont mode and the resolution of the printer. If you do not know what a Metafont mode is, you can see it as a printer driver: it adapts the design of TeX fonts to ensure that they give the best possible result on your printer. Be warned however that, if you define different Metafont modes for different printers, dvips will generate several copies of your TeX fonts on disk, and these take valuable space.

Once you are satisfied that your printers are correctly configured, you should tell LyX to make use of this configuration. To do this, you should launch the Preferences dialog (Tools>Preferences), select the Printer tab, and set the entries Adapt output and Spool command.

You can use as many configuration files as you like, one for each of your printers.

---

6In particular, this file is not necessarily connected to the existence of a file named ps.
The default printer for \LaTeX{} can be specified from the Preferences dialog or with the PRINTER environment variable. You can also choose the desired printer from inside \LaTeX{}, as described in a later section. Once you’ve done all that, you can print to either a PostScript printer or file from \LaTeX{}.

If your printer doesn’t understand PostScript®, you’ll need to use ghostscript as a filter for your print spooler. That’s covered in numerous HOWTO’s and manuals. We also have a section that covers a little bit of this.

Some people don’t seem to like using the dvips plus ghostscript combination. As an alternative, you can use a program that converts the DVI file directly into your printer language. You can specify this program in the Preferences dialog, too. There is a major disadvantage to this method. You can’t include any PostScript files, such as graphics, in your documents, since the printer-specific conversion programs don’t understand PostScript®. For that reason, the \LaTeX{} team highly recommends using dvips and ghostscript for printing.

### 2.5.3 Ghostscript, Xdvi and Ghostview

Xdvi and ghostview are viewers. The former handles .dvi files, while the later interfaces with ghostscript to allow you to view PostScript files.

A quick note on both of these programs. Both automatically update themselves if the viewed file changes. You can also force an update. So, once you’ve opened one of these two viewers, there’s no reason to close it. Also, both programs are functionally the same, providing all of the same features.

The \LaTeX{} team recommends using xdvi for fine tuning documents. Why? It’s faster; there’s one less layer of processing you need to do before you can view the changes. Here’s an example:

1. Use xdvi to preview a document from \LaTeX{}, and leave it running.
2. Make changes to the document using \LaTeX{}.
3. To view those changes, just choose View \textendash Update \textendash DVI. When \LaTeX{}’s all done, click on the xdvi window, and voilà! xdvi will update itself.

Now, this doesn’t mean ghostview is useless. ghostview is better suited to those occasions where you must view the PostScript version of the document. For repeated changes that aren’t PostScript® dependent, you’re better off previewing with xdvi. There is an alternative to ghostview which sports a much better interface: gv. \LaTeX{} will automatically use it instead of ghostview if it is available.

### 2.6 The Printer

Anyone working on a large system shouldn’t have any problems here. Your sysadmin [or you, if you are the sysadmin] should already have the printers set up for your

---

\footnote{That means the .dvi or .ps file, not the files used to make these.}
system. All you need to do is find out the name of the printer you want to use, and configure your setup as described in the last section.

Those of you using Linux, however, may have a bit more work to do. Many people now install Linux from an ISO image of one of the popular distributions. They follow the install instructions, get Linux up and running, but never realize that they need to set up their printer. The more desktop friendly distributions may do this for you automatically. However, if you find that you need to do this by hand, we’ve written a little something to help you out with that; check out the “A Printer Tutorial” chapter in the Customization manual for help.
2 \LaTeX\ Setup and Supporting Applications
3 LyX Basics

3.1 Document Types

3.1.1 Introduction

Before you do anything else, before you ever start writing a document, you need to decide what type of document you want to edit. Different types of documents use different types of spacing, headings, numbering schemes, and so on. Additionally, different documents use different paragraph environments, and format the title of your document differently.

A document class describes a group of properties common to a particular set of documents. By setting the document class, you automagically select these properties, making it easier to create the type of document you want. If you don’t choose a document class, LyX picks one for you by default. So, it behooves you to change the class of your document.

Read on for info about the document classes you can choose from LyX, and how to fine-tune some of their properties.

3.1.2 The Various Document Classes

3.1.2.1 Overview

There are five standard document classes in LyX. They are:

- **Article** for basic articles
- **Report** for basic reports
- **Book** for writing a book
- **Letter** for US-style letters
- **Slides** is used to make transparencies

There are also some non-standard classes, which LyX only uses if you have a \TeX setup that supports them:

- **Aapaper** Journal articles in the style and format used in Astronomy & Astrophysics
Amsart  Journal articles in the style and format used by the AMS [American Mathematical Society]. There are three amsart layouts available. The standard one uses a typical numbering scheme for theorems, etc., that prepends the section number to the number of the result. All result-type statements (propositions, corollaries, and so on) are sequenced together, but definitions, examples, and the like have their own sequence. The “sequential numbering” scheme does not place the section number with each result, but numbers them throughout the article in a single sequence. Each type of result gets its own sequence. There is also a layout that dispenses with numbering of statements altogether.

Amsbook  Books in the style and format used by the AMS. Only the standard numbering scheme is provided, under the assumption that you would not want to number results consecutively throughout a book, and that you would need to number results.

Dinbrief  für Briefe nach deutscher Art

Foils  is used to make transparencies, but is better than slides

Linuxdoc  Used with the SGML-tools package (formerly known as LinuxDoc). It allows LyX to produce SGML output. SGML is a markup language and is the predecessor to HTML. The SGML-tools package allows you to convert SGML to HTML or to the format used by man pages.

Paper  for use with the paper \LaTeX document class [not in all \LaTeX distributions]

Revtex  is used to write articles for the publications of the American Physical Society (APS), American Institute of Physics (AIP), and Optical Society of America (OSA). This class is not completely compatible with all LyX features.

We won’t go into any detail about how to use these different document classes here. You can find all the details about the non-standard classes in the Extended Editing manual. Here, we will settle with a list of some of the common properties of all of the document classes.

3.1.2.2 Selecting a Class

You can select a class using the Document\textgreater Settings dialog. Select the class you want to use, and make any fine tunings of the options you may need.

3.1.2.3 Properties

Each class has a default set of options. Here’s a quick table describing them:
There is no default value of Extra Options for any of these classes. You’re probably also wondering what “Max. sectioning level” means. There are several paragraph environment used to create section headings. Different document classes allow different types of section headings. Only two use the Chapter heading; the rest do not and begin instead with the Section heading. Some document classes, such as the three for letters, don’t use any section headings. In addition to Chapter and Section headings, there are also Subsection headings, Subsubsection headings, and so on. We’ll describe these headings fully in section 3.3.4.

### 3.1.3 Fine-tuning the Defaults

Okay, we know we never told you what most of these “default options” set by the Class button do. That’s what this section is for.

#### Pagestyle

This is another list, containing five options. It controls what sorts of headings and page numbers go on a page:\(^1\)

<table>
<thead>
<tr>
<th></th>
<th>Pagestyle</th>
<th>Sides</th>
<th>Columns</th>
<th>Max. sectioning level</th>
</tr>
</thead>
<tbody>
<tr>
<td>article</td>
<td>Plain</td>
<td>One</td>
<td>One</td>
<td>Section</td>
</tr>
<tr>
<td>report</td>
<td>Plain</td>
<td>One</td>
<td>One</td>
<td>Chapter</td>
</tr>
<tr>
<td>book</td>
<td>Headings</td>
<td>Two</td>
<td>One</td>
<td>Chapter</td>
</tr>
<tr>
<td>letter</td>
<td>Plain</td>
<td>One</td>
<td>One</td>
<td>none</td>
</tr>
<tr>
<td>linuxdoc</td>
<td>Plain</td>
<td>One</td>
<td>One</td>
<td>Section</td>
</tr>
<tr>
<td>aapaper</td>
<td>Plain</td>
<td>Two</td>
<td>Two</td>
<td>Section</td>
</tr>
<tr>
<td>amsart</td>
<td>Headings</td>
<td>One</td>
<td>One</td>
<td>Section</td>
</tr>
<tr>
<td>dinbrief</td>
<td>Plain</td>
<td>One</td>
<td>One</td>
<td>none</td>
</tr>
<tr>
<td>paper</td>
<td>Headings</td>
<td>One</td>
<td>One</td>
<td>Section</td>
</tr>
</tbody>
</table>

\(^1\)\LaTeX\ does this part.
Sides

No, \LaTeX{} can’t make your printer print on both sides of a sheet of paper! However, it can use a different format for odd-numbered pages than even-numbered pages. This way, if you do have a printer that duplexes\(^2\), your page number will always be in the upper right corner of the page and the left margin will have extra room for a binding.

There are two radio buttons here: \textbf{One} for single-sided documents, \textbf{Two} for double-sided documents.

Columns

Yes, this does control how many columns each page has. You can choose, using the toggle buttons, \textbf{One} or \textbf{Two} for the number of columns.

Note that \LaTeX{} won’t show two columns on screen. That’s impractical, often unreadable, and not part of the WYSIWYM concept. However, there \textit{will} be two columns in the generated output.

Extra Options

The \TeX{} command \texttt{\documentclass} takes several options. \LaTeX{} sets some of these automatically for you. This text box allows you to enter in others. Just type in a comma-separated list of options. See a good \LaTeX{} book to find out what kinds of additional options you can use.

Separation

This has its own section. See sec. 3.2.1 for a description of what this does.

3.1.4 Paper Size, Orientation, and Margins

There are several other options to set in the Document Settings dialog. All of them are global options, but they have special purposes and only affect certain features. We describe what these options do in the same section that describes the features they affect.

There are two options that affect the overall layout of the document, so we’ll describe them here. You’ll find them in the Paper dialog under the Layout menu:

Orientation Two toggle buttons choose whether to print the output as \texttt{Landscape} or as \texttt{Portrait}.

Papersize What size paper to print on. The choices are

\begin{itemize}
  \item Default
  \item A3, A4, A5
  \item B3, B4, B5
  \item US Letter
\end{itemize}

\(^2\)i.e. prints on both sides of a sheet of paper
3.2 Paragraph Indentation and Separation

- US legal
- US executive
- Custom

Some of these settings require you to have the `geometry` package installed. This package will also allow you to set the margins in the `Paper` dialog.

3.1.5 Important Note:

If you change a document’s class, LyX has to convert *everything* into the new class. That includes the paragraph environments. Some paragraph environments are standard; all of the document classes have them. Some classes have special paragraph environments, however. If this is the case, and you change document classes, LyX sets the missing paragraph environments to *Standard* and places an error box at the beginning of the paragraph. Just click on them and you’ll get a message dialog that tells you about the conversion and why it failed.

3.2 Paragraph Indentation and Separation

3.2.1 Introduction

Before describing all of the various paragraph environments, we’d like to say a word or two about paragraph indentation.

Everyone seems to have their own convention for separating paragraphs. Most Americans indent the first line of a paragraph. Others don’t indent but put extra space between the paragraphs. LyX uses the same convention you find among typographers. The first paragraph of a section, or after a figure, an equation, a table, a list, etc., is *not* indented. Only a paragraph following another paragraph gets indented. Some people don’t like this convention, but if you want to use indented paragraphs, you’ll have to live with it.³

The space between paragraphs, like the line spacing, the space between headings and text — in fact, all of the spacings for just about everything are pre-coded into LyX. As we said, you don’t worry about how much space to add between what. LyX takes care of that. In fact, these pre-coded vertical spacings aren’t a single number but a range. That way, LyX can squish or stretch the space between lines to make sure figures fit on a page with text, so that sections don’t start at the bottom of a page, and so on.⁴ However, pre-coded doesn’t mean you can’t change them. LyX gives you the ability to globally change *all* of these pre-coded spacings. We’ll explain more later.

³There is a way to force LaTeX to indent all paragraphs. LyX won’t show this, of course, but LaTeX will print it that way. You’ll need to get a special package and insert an appropriate command in the preamble.
⁴Actually, LaTeX does this when LyX goes to produce a printable file.
3.2.2 Global Indentation Method

To select the default method of separating paragraphs, select \texttt{Indent} or \texttt{Skip} to indent paragraphs or add extra space between paragraphs, respectively.

3.2.3 Fine-Tuning

You can also change the separation method of a single paragraph. Open the \textit{Edit} \rightarrow \textit{Paragraph Settings} dialog and toggle the \texttt{No Indent} button to change the state of the current paragraph. If paragraphs indent by default, this button will be inactive at first. If paragraphs have no indentation but use extra space for separation, this button will be completely ignored (you can’t indent a single paragraph by toggling this).

You should only need to change the indentation method for a single paragraph if you need to do some fine-tuning. Typically, you’ll select \texttt{Indent} or \texttt{Skip} for the entire document and edit away.

3.2.4 Changing Line Spacing

In the \textit{Document} \rightarrow \textit{Settings} dialog you can choose your line spacing provided you have the \texttt{setspace} package installed.

3.3 Paragraph Environments

3.3.1 Overview

The paragraph environments correspond to the various
\begin{environment} \ldots \end{environment}
command sequences in an ordinary \LaTeX file. If you don’t know \LaTeX, or the concept of a paragraph environment is totally alien to you, we urge you to read the \textit{Tutorial}. The \textit{Tutorial} also contains many more examples than this section does.

A paragraph environment is simply a “container” for a paragraph which gives that paragraph certain properties. This can include a particular style of font, different margins, a numbering scheme, labels, and so on. Additionally, you can “nest” the different environments inside one another, allowing one environment to inherit some of the properties of another. The different paragraph environments totally replace the need for messy tab stops, on the fly margin adjustment, and other hold-overs from the days of typewriters. There are several paragraph environments which are specific to a particular document type. We’ll only be covering the most common ones here.

To choose a new paragraph environment, use the pull-down box on the left end of the toolbar. \LaTeX will change the environment of the \textit{entire} paragraph in which the cursor sits. You can also change the environment of an entire group of paragraphs if you select them before choosing the new environment.
3.3 Paragraph Environments

Note that hitting Return will typically create a new paragraph using the Standard paragraph environment. We say “typically” because this isn’t always the case. Usually, starting a new paragraph resets both the paragraph environment and the nesting depth [more on nesting in section 3.4]. At the moment, all this is context-specific; you’re better off expecting Return to reset the paragraph environment and depth. If you want a new paragraph to keep the current environment and depth, use M-Return instead.

3.3.2 Standard

The default paragraph environment is Standard for most classes. It creates a plain paragraph. If LYX resets the paragraph environment, this is the one it chooses. In fact, the paragraph you’re reading right now [and most of the ones in this manual] are in the Standard environment.

You can nest a paragraph using the Standard environment in just about anything else, but you can’t really nest anything in a Standard environment.

3.3.3 Document Titles

A LATEX title page has three parts: the title itself, the name[s] of the author[s] and a “footnote” for thanks or contact information. For certain types of documents, LATEX places all of this on a separate page along with today’s date. For other types of documents, the title “page” goes at the top of the first page of the document.

LYX provides an interface to the title page commands through the paragraph environments Title, Author, and Date. Here’s how you use them:

- Put the title of your document in the Title environment.
- Put the author name in the Author environment.
- If you want the date to have a certain appearance, want to use a fixed date, or want other text to appear in place of today’s date, put that text in the Date environment. Note that using this environment is optional. If you don’t provide any, LATEX will automatically insert today’s date.

Be sure to do this at the top of the document. You can use footnotes to insert “thanks” or contact information.

5If you are in one of these environments:
- Quote
- Quotation
- Verse
- Itemize
- Enumerate
- Description
- List

LYX keeps the old paragraph environment when you hit Return, rather than resetting it to Standard. LYX will still reset the nesting depth, however.
3.3.4 Headings

There are nine paragraph environments for producing section headings. LyX takes care of the numbering for you. All you need to do is decide what you’re going to call section 3 of chapter 9.

3.3.4.1 Numbered Headings

There are 6 numbered types of section headings. They are:

1. Chapter
2. Section
3. Subsection
4. Subsubsection
5. Paragraph
6. Subparagraph

LyX labels each heading with a series of numbers, separated by periods. The numbers describe where in the document you are. These headings all subdivide your document into different pieces of text. For example, suppose you’re writing a book. You group the book into chapters. LyX does similar grouping:

- Either Chapter or Section is the maximum sectioning level.
- Chapters are divided into Sections
- Sections are divided into Subsections
- Subsections are divided into Subsubsections
- Subsubsections are divided into Paragraphs
- Paragraphs are divided into Subparagraphs

Note: not all document types use the Chapter heading as the maximum sectioning level. In that case, the Section is the top-level heading.

So, if you use the Subsubsection environment to label a new sub-subsection, LyX labels it with its number, along with the number of the subsection, section, and, if applicable, chapter that it’s in. For example: the fifth section of the second chapter of this book has the label “2.5”.

24
3.3.4.2 Unnumbered Headings

There are 3 types of unnumbered section headings. They are:

1. Section*
2. Subsection*
3. Subsubsection*

The “*” after each name means that these headings are not numbered. They work the same as their numbered counterparts.

3.3.4.3 Changing the Numbering

You can also alter which sectioning levels get numbered and which ones appear in the Table of Contents. Now, this doesn’t remove any of the levels; that’s preset in the document class. Certain classes start with Chapter and go down to the Subparagraph level. Others start at Section. Similarly, not all document classes number all sectioning levels. Most don’t number Paragraph or Subparagraph. This is something you can change.

Open the Document \textit{Settings} dialog. You should see a counter labelled 	extit{Section numbering depth} under the Extra tab. This counter controls how far down in the sectioning hierarchy \LaTeX{} numbers a section heading. Unfortunately, the number you choose with the slider is really goofy, so here’s a table of values and what they do:

<table>
<thead>
<tr>
<th>Sec. Num. Depth value:</th>
<th>\LaTeX{} numbers these section headings:</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2</td>
<td>no numbering of any kind</td>
</tr>
<tr>
<td>-1</td>
<td>add Parts</td>
</tr>
<tr>
<td>-0 and 0</td>
<td>add Chapters</td>
</tr>
<tr>
<td>1</td>
<td>add Sections</td>
</tr>
<tr>
<td>2</td>
<td>add Subsections</td>
</tr>
<tr>
<td>3</td>
<td>add Subsubsections</td>
</tr>
<tr>
<td>4</td>
<td>add Paragraphs</td>
</tr>
<tr>
<td>5</td>
<td>add Subparagraphs</td>
</tr>
</tbody>
</table>

The increasing numbers are cumulative: a setting of “0” will number parts and chapters, while “2” will number parts, chapters, sections, and subsections. Of course, if you’re using a document class that doesn’t use part or chapter headings (\textit{e.g.} the default article class), then the numbering begins at the Section heading, and “0” also corresponds to “no numbering.”

There’s another counter in the dialog, called \textit{Table of contents depth}. It works the same way as \textit{Section numbering depth}, only it controls which sectioning levels appear
in, you guessed it, the Table of Contents. This is a great control to have. Suppose you wanted to number all sectioning headings, but you only wanted Chapters, Sections, and Subsections in the Table of Contents. You’d just set Section numbering depth to “5” and Table of contents depth to “2” and voilà! You’re all set.

### 3.3.4.4 Special Information

The following information applies to Chapter, Section, Subsection, Subsubsection, Paragraph, Subparagraph as well as Section*, Subsection*, and Subsubsection*:

- You cannot use a margin note in any of these environments.
- You can only use inlined math in these environments.
- You cannot nest other environments into these environments.
- You can use labels and cross-references to refer to their numbers.

As for examples of these paragraph environments - look around you! We’re using them everywhere in the manuals.

### 3.3.4.5 Creating an Appendix

To create an appendix, simply start by adding a new chapter or section heading. Move the cursor back to the beginning of the heading and select Document ≫ Start Appendix Here. A red/brown box will be drawn around the remainder of the file to indicate there is something special about it, and the numerical chapter or section label(s) will be changed to a letter.

### 3.3.5 Quotes and Poetry

\LaTeX{} has three paragraph environments for writing poetry and quotations. They are Quote, Quotation, and Verse. Forget the days of changing linespacing and twiddling with margins. These three paragraph environments already have those changes built-in. They all widen the left margin and add a bit of extra space above and below the text they contain. They also allow nesting, so you can put a Verse in a Quotation, as well as in some other paragraph environments.

There is another feature of these three paragraph environments: they do not reset to Standard when you start a new paragraph. So, you can type in that poem and merrily hit Return without worrying about the paragraph environment changing on you. Of course, that means that, once you’re done typing in that poem, you have to change back to the Standard environment yourself.
3.3 Paragraph Environments

3.3.5.1 Quote and Quotation

Now that we’ve described the similarities of these three environments, it’s time for
the differences. Quote and Quotation are identical except for one difference: Quote
uses extra spacing to separate paragraphs and never indents the first line. Quotation
always indents the first line of a paragraph and uses the same line spacing throughout.

Here’s an example of the Quote environment:

This is in the Quote environment. I can keep writing, extending this line
out further and further until it wraps. See - no indentation!

Here’s the second paragraph of this quote. Again, there’s no indentation,
but there is extra space between me and the other paragraph.

That ends that example. Here’s another example, this time in the Quotation environ-
ment:

This is in the Quotation environment. If I keep writing, you’ll see the
indentation. If your country uses a writing style that shows off new para-
graphs by indenting the first line, then Quotation is the environment for
you! Well, you’d use it if you were quoting other text.

Here’s a new paragraph. I could ramble on and on, like a politician at
election time. If I did that, though, you’d get bored.

That was our other example. As the example notes, Quote is for those people who use
extra space to separate paragraphs. They should put quotes in the Quote environ-
ment. Those who use indentation to mark a new paragraph should use the Quotation
paragraph environment for quoted text.

3.3.5.2 Verse

Verse is a paragraph environment for poetry, rhymes, verses, and so on. Here’s an
example:

This is in Verse
Which I did not rehearse!

It could be much worse. This line could be long, very long, oh so long,
so very long that it wraps around. It looks okay on screen, but in the
printed version, the extra lines are indented a bit more than the first.
Okay, so it’s turned to prose and doesn’t rhyme anymore. So sue me.

To break a line
And make things look fine
Use C-Return.

As you can see, Verse does not indent both margins. Each stanza of the verse or
poem is in its own paragraph. To separate the individual lines of a stanza, use the
break-line function, C-Return.
3 \LaTeX Basics

3.3.6 Lists

\LaTeX has four different paragraph environments for creating different kinds of lists. In the Itemize and Enumerate environments, \LaTeX labels your list items with bullets or numbers, respectively. In the Description and List environments, \LaTeX lets you provide your own label. We'll present the individual details of each type of list next after describing some general features of all four of them.

3.3.6.1 General Features

The four paragraph environments for lists differ from the other environments in several ways. First, \LaTeX treats each paragraph as a list item. Hitting Return does not reset the environment to Standard but keeps the current environment and creates a new list item. The nesting depth is typically reset, however. If you want to keep both the current nesting depth and paragraph environment, you should use M-Return to break paragraphs.

You can nest lists of any type inside one another. In fact, \LaTeX changes the labels on some list items depending on how its nested. If you intend to use any of the list paragraph environments, we suggest you read all of section 3.4.

3.3.6.2 Itemize

The first type of list we’ll describe in detail is the Itemize paragraph environment. It has the following properties:

- Each item has a particular bullet or symbol as its label.
  - \LaTeX uses the same symbol for all of the items in a given nesting level.
  - The symbol appears at the beginning of the first line.

- The items can be any length. \LaTeX automatically offsets the left margin of each item. The offset is always relative to whatever environment the Itemize list may be in.

- If you nest an Itemize environment inside another Itemize environment, the label changes to a new symbol.
  - There are four different symbols for up to a four-fold nesting.
  - \LaTeX always shows the same symbol, an asterisk, on screen.
  - See section 3.4 for a full explanation of nesting.

Of course, that explanation was also an example of an Itemize list. The Itemize environment is best suited for lists where the order doesn’t matter.

We said that different levels use different symbols as their label. Here’s an example of all four possible symbols. Note that those of you reading this manual online won’t see any difference.
• The label for the first level `itemize` is a large black dot, or bullet.
  – The label for the second level is a dash.
    * The label for the third is an asterisk.
      · The label for the fourth is a centered dot.
    * Back out to the third level.
  – Back to the second level.
• Back to the outermost level.

These are the default labels for an `itemize` list. You can customize these labels in the
`Document > Settings` dialog in the `Bullets` tab.

Notice how the space between items decreases with increasing depth. We’ll explain
nesting and all the tricks you can do with different depths in section 3.4. Be sure to
read it!

3.3.6.3 Enumerate

The `enumerate` environment is the tool to use to create numbered lists and outlines.
It has these properties:

1. Each item has a numeral as its label.
   a) The type of numeral depends on the nesting depth.
2. `LATEX` automatically counts the items for you and updates the label as appropri-
   ate.
3. Each new `enumerate` environment resets the counter to one.
4. Like the `itemize` environment, the `enumerate` environment:
   a) Offsets the items relative to the left margin. Items can be any length.
   b) Reduces the space between items as the nesting depth increases.
   c) Uses different types of labels depending on the nesting depth.
   d) Allows up to a four-fold nesting.

Unlike the `itemize` environment, `enumerate` does show the different labels for each
item. Here is how `LATEX` labels the four different levels in an `enumerate`:

1. The first level of an `enumerate` uses Arabic numerals followed by a period.
   a) The second level uses lower case letters surrounded by parentheses.
     i. The third level uses lower-case Roman numerals followed by a period.
A. The fourth level uses capital letters followed by a period.

B. Again, notice the decrease in the spacing between items as the nesting depth increases.

ii. Back to the third level

b) Back to the second level.

2. Back to the outermost level.

Once again, you can customize the type of numbering used in the \texttt{Enumerate} environment. It involves adding commands to the \LaTeX{} preamble (see the \textit{Extended Features} manual), however. As stated earlier, such customization only shows up in the printed version, not on the \LaTeX{} screen.

There is more to nesting \texttt{Enumerate} environments than we've stated here. You \textit{really} should read section 3.4 to learn more about nesting.

3.3.6.4 Description

Unlike the previous two environments, the \texttt{Description} list has no fixed label. Instead, \LaTeX{} uses the first “word” of the first line as the label. Here's an example:

\textbf{Example:} This is an example of the \texttt{Description} environment.

\LaTeX{} typesets the label in boldface and puts extra space between it and the rest of the line.

Now, you're probably wondering what we mean by, “uses the first 'word'.” The \texttt{Space} key does not add a whitespace character, but separates words from one another. Inside of a \texttt{Description} environment, the \texttt{Space} key tells \LaTeX{} to end the label if we're at the beginning of the first line of an item.

However, what if you want or need to use more than one word in the label of a \texttt{Description} environment? Simple: use a \texttt{Protected Blank}. [Use either \texttt{C-Space} or \texttt{Special Formatting\textgreater Protected Space} from the \texttt{Insert} menu. See sec. 6.6.1 for more info.] Here's an example:

\textbf{Second Example:} This one shows how to use a \texttt{Protected Blank} in the label of a \texttt{Description} list item.

\textbf{Usage:} You should use the \texttt{Description} environment for things like definitions and theorems. Use it when you need to make one word in particular stand out in the text that describes it. It’s not a good idea to use a \texttt{Description} environment when you have an entire sentence that you want to describe. You’re better off using \texttt{Itemize} or \texttt{Enumerate} and nesting several \texttt{Standard} paragraphs into them.

\textbf{Nesting:} You can, of course, nest \texttt{Description} environments inside one another, nest them in other types of lists, and so on.

Notice that after the first line, \LaTeX{} indents subsequent lines, offsetting them from the first line.
3.3.6.5 The LyX List

The List environment is a LyX extension to \LaTeX{}.

Now, if you jumped here without reading sections 3.3.6.2-3.3.6.4, you’ve goofed. The List environment does not create numbered lists. That’s what \texttt{Enumerate} does, and it’s documented in section 3.3.6.3.

Like the Description environment the List environment has user-defined labels for each list item. There are some key differences between this list environment and the other three:

- **item labels** LyX uses the first “word” of each line as the item label. The first Space after the beginning of the first line of an item marks the end of the label. If you need to use more than one word in an item label, use a protected blank as described above.

- **margins** As you can see, LyX uses different margins for the item label and the body of the item text. The body of the text has a larger left margin, which is equal to the default label width plus a little extra space.

- **label width** LyX uses one of two things for the label width: the actual width of the label, or the default width, whichever is larger. If the actual width is larger, then the label “extends” into the first line. In other words, the text of the first line isn’t aligned with the left margin of the rest of the item text.

- **default width** You can very easily set this default width. It’s quite painless, actually. So, you can easily ensure that the text of all items in a List environment have the same left margin.

- **uses** You should use the List environment the same way you’d use as Description list: when you need one word to stand out from the text that describes it. The List environment gives you another way to do this, using a different overall layout.

- **nesting** You can nest List environments inside one another, nest them in other types of lists, and so on. They work just like the other list paragraph environments. Read section 3.4 to learn about nesting.

As you can see, this is a feature-packed paragraph environment!

To change the default width of the label, select the items in the list to change. You can also simply move the cursor into a List item if you want to change only its label width. Now open the \texttt{Edit\textgreater{}Paragraph Settings} dialog and find the Label width text box. The text in the Label width box determines the default label width. If you really, really want to, you can use the text of your largest label here, but you don’t need to. We recommend using the letter “M” multiple times. It’s the widest character and is a standard unit of width in \LaTeX{}. The default label width in the example List is 6
“M”’s wide. Using “M” as your unit of width in the Label Width box has one more
advantage: you don’t need to keep changing the contents of Label Width every time
you alter a label in a List environment.

There’s yet another feature of the List environment we need to tell you about. As
you can see in the examples, LyX left-justifies the item labels by default. You can use
additional HFills to change how LyX justifies the item label. We’ll document HFills
later in section 6.6.1. Here are some examples:

Left  The default for List item labels.

Right  One HFill at the beginning of the label right justifies it.

Center One HFill at the beginning of the label and one at the end centers it.

Don’t worry if you have no idea what HFills are yet. Just remember that you can use
them to customize the look of the List environment.

That does it for the four paragraph environments for making lists. Oh - did we
mention that you should read about nesting environments in section 3.4 if you want
to use any of these list environments?

3.3.7 Letters

3.3.7.1 Address and Right Address: An Overview

Although LyX has document classes for letters, we’ve also created two paragraph
environments called Address and Right Address. To use the letter class, you need to
use specific paragraph environments in a specific order, otherwise LaTeX gags on the
document. In contrast, you can use the Address and Right Address paragraph environ-
ments anywhere with no problem. You can even nest them inside other environments,
though you can’t nest anything in them.

Of course, you’re not limited to using Address and Right Address for letters only.
Right Address, in particular, is useful for creating article titles like those used in some
European academic papers.

3.3.7.2 Usage

The Address environment formats text in the style of an address, which is also used for
the opening and signature in some countries. Similarly, the Right Address environment
formats text in the style of a right-justified address, which is used for the sender’s
address and today’s date in some countries. Here’s an example of each:

Right Address
WhoAmI
WhereAmI
When is it? What is today?
3.3 Paragraph Environments

That was **Right Address**. Notice that the lines all have the same left margin, which \LaTeX sets to fit the largest block of text on a single line. Here’s an example of the `Address` environment:

WhoAreYou
Where do I send this
Your post office and country

As you can see, both `Address` and `Right Address` add extra space between themselves and the next paragraph. Speaking of which, if you hit `Return` in either of these environments, \LaTeX resets the nesting depth and sets the environment to `Standard`. This makes sense, however, since `Return` is the `break-paragraph` function, and the individual lines of an address are not paragraphs. Thus, you’d use `break-line` (`C-Return` or `Special Formatting→Linebreak` from the `Insert` menu) to start a new line in an `Address` or `Right Address` environment.

### 3.3.8 Academic Writing

Most academic writing begins with an abstract and ends with a bibliography or list of references. \LaTeX contains paragraph environments for both of these.

#### 3.3.8.1 Abstract

The `Abstract` environment is used for the abstract of an article. Technically, you *could* use this environment anywhere, but you really *should* only use it at the beginning of the document, after the title. The `Abstract` environment is only useful in the “article” and “report” document classes [as well as “amsart,” which is just a specialized version of “article”]. The “book” document class ignores the `Abstract` completely, and it’s utterly silly to use `Abstract` in the “letter” document class.

The `Abstract` environment does several things for you. First, it puts the centered label “Abstract” above the text. The label and the text of the abstract are separated by some extra vertical space. Second, it typesets everything in a smaller font, just as you’d expect. Lastly, it adds a bit of extra vertical space between the abstract and the subsequent text. Well, that’s how it will appear on the \LaTeX screen. If your document is in the “report” class, the abstract actually appears on a separate page in the printed version of the file.

Starting a new paragraph by hitting `Return` does *not* reset the paragraph environment. The new paragraph will still be in the `Abstract` environment. So, you will have to change the paragraph environment yourself when you finish entering the abstract of your document.

We’d love to give you an example of the `Abstract` environment, but we can’t, since this document is in the “book” class. If you’ve never heard of an “abstract” before, you can safely ignore this environment.
3.3.8.2 Bibliography

The Bibliography environment is used to list references. Technically, you could use this environment anywhere, but you really should only use it at the end of the document. Also, don’t bother trying to nest Bibliography in anything else or vice versa. It won’t work.

When you first open a Bibliography environment, LyX add a large vertical space, followed by the heading “Bibliography” or “References,” depending on the document class. The heading is in a large boldface font. Each paragraph of the Bibliography environment is a bibliography entry. Thus, hitting Return does not reset the paragraph environment. Each new paragraph is still in the Bibliography environment.

At the beginning of the first line of each paragraph, you will see a gray button showing a number. If you click on it, you will get a dialog in which you can set a key and a label. The key is the symbolic name by which you will refer to this bibliography entry. For example, suppose your first entry in the bibliography was a book about $\LaTeX$. We could choose the key “latexguide” for that entry. You can also give a label, which will be displayed in the gray inset box.

The key field isn’t useless. You can refer to your bibliography entries using the \textbf{Insert $\nearrow$ Citation} command. Just choose the key inside in the available keys list, then add a reference by clicking on the left arrow, which will add it to the selected keys list. Multiple references can be placed by selecting more than one key. An example of the Bibliography appears at the end of this document. “See [4] or [3, Chapter 3]” is an example of how to cite two of the entries in it. In the second one, we used the \textbf{Text after} field of the citation dialog to add the text “Chapter 3”. The texts “latexguide” and “latexcompanion” that you see on screen will be replaced in print by the number or the label of the bibliography entry.

The more advanced $\LaTeX$ bibliography package Bib$\LaTeX$ is also supported by LyX. For a description of how to use it, please refer to the Extended $\LaTeX$ Features document.

3.3.9 Special Purpose

There are three standard paragraph environments that simply don’t fit any category, as they are very specialized for a particular purpose. We’ll point out the highlights and uses of each.

3.3.9.1 Caption

The Caption environment is the default paragraph environment for Figure Floats and Table Floats. On the LyX screen, you’ll see either the label “Figure #:” or “Table #:”, depending on which type of Float it’s in. The actual reference number is substituted in this label in the printed output.

You can’t really nest things into a Caption environment. Additionally, hitting \textbf{Return} resets the paragraph environment to Standard, so a Caption can only be a single paragraph.
3.3 Paragraph Environments

You cannot use a Caption environment outside of a Figure Float or a Table Float. See sections 4.3 and 4.4 for more information on Figure Floats and Table Floats.

3.3.9.2 LyX-Code

The LyX-Code environment is another LyX extension. It type-sets text in a typewriter-style font. It also treats the Space key as a fixed whitespace;\(^6\) this is the only case in which you can type multiple whitespaces in LyX. If you need to insert blank lines, you’ll still need to use C-Return [the break-line function]. Return breaks paragraphs. Note, however, that Return does not reset the paragraph environment. So, when you finish using the LyX-Code environment, you’ll need to change the paragraph environment yourself. Also, you can nest the LyX-Code environment inside of others.

There are a few quirks with this environment:

- You cannot use C-Return at the beginning of a new paragraph [i.e. you can’t follow Return with a C-Return].

- You can’t follow a C-Return with a Space.
  - Use a Return to begin a new paragraph, then you can use a Space.
  - Or: use C-Space instead.

- You can’t have an empty paragraph or an empty line. You must put at least one Space in any line you want blank. Otherwise, \LaTeX generates errors.

- You cannot get the typewriter double quotes by typing " since that will insert real quotes. You get the typewriter double quotes with C-" (or C-q if you use Emacs-like key bindings).

Here’s an example:

```latex
\begin{verbatim}
#include <stdio.h>

int main(void)
{
  printf("Hello World\n");
  return 0;
}
\end{verbatim}
```

This is just the standard “Hello world!” program.

LyX-Code has one purpose: to typeset code, such as program source, shell scripts, rc-files, and so on. Use it only in those very, very special cases where you need to generate text as if you used a typewriter.

\(^6\)In the LyX-Code environment, the Space key is treated as a Protected Blank instead of an end-of-word marker.
3.4 Nesting Environments

3.4.1 The Big Deal

Throughout the previous sections, we’ve been nagging you to “go read Section 3.4.” So, you’re probably wondering what the big deal is.

The big deal is that LyX differs rather strongly from the traditional “wordprocessor-as-overglorified-typewriter” concept. With a typewriter, text is merely ink on a page. Most word processors aren’t much better, treating text as pixels on the screen and bytes in memory. In contrast, LyX treats text as a unified block with a particular context and specific properties. However, what if you wanted one “block” to inherit some of the properties of another “block”?

Here’s a more specific example: outlines. You have three main points in your outline, but point #2 also has two subpoints. In other words, you have a list inside of another list, with the inner list “attached” to item #2:

1. one
2. two
   a) sublist - item #1
   b) sublist - item #2
3. three

How do you put a list inside of a list? By now, the answer should be obvious: you nest one list inside the other.

How to nest an environment is quite simple. Select Increase Environment Depth or Decrease Environment Depth from the Edit menu to change the nesting depth of the current paragraph (the status bar will tell you how far you are nested).

You can also use the convenient key bindings S-M-Left and S-M-Right to change the nesting level. The change will work on the current selection if you have made one (allowing you to change the nesting of several paragraphs at once), or the current paragraph.

Note that LyX only changes the nesting depth if it can. If it’s invalid to do so, nothing happens if you try to change the depth. Additionally, if you change the depth of one paragraph, it affects the depth of every paragraph nested inside of it. It’s hard to describe what exactly LyX does in this case. That depends specifically on what your text looks like. Your best bet is to simply play with changing the nesting depth and see what happens.

Nesting isn’t just limited to lists. In LyX, you can nest just about anything inside anything else, as you’re about to find out. This is the real power of nesting paragraph environments.

7M-p Left and M-p Right are alternatives, if you prefer those bindings.
3.4 Nesting Environments

3.4.2 What You Can and Can’t Nest

Before we fire a list of paragraph environments at you, we need to tell you a little bit more about how nesting works.

The question of nesting is a bit more complicated than a simple yes or no, can you or can’t you. There’s also the question of how. Can you nest this environment into anything else? Can you nest another environment into it? A “yes” to one of these doesn’t guarantee a “yes” to the other.

The paragraph environments in \LaTeX{} can do one of three things when it comes to nesting. First, an environment may be completely unnestable. Second, there are environments that are fully nestable. You can nest them inside of things and you can also nest other things inside of them. There is one last type of environment. You can nest them into other environments, but that’s it. You can’t nest anything into them.

Here’s a list of the three types of nesting behavior, and which paragraph environments have them:

**Unnestable** Can’t nest them. Can’t nest into them.

- Bibliography
- Title
- Author
- Date

**Fully Nestable** You can nest them. You can nest other things into them.

- Abstract
- Verse
- Quote
- Quotation
- Itemize
- Enumerate
- Description
- List
- \LaTeX{}-Code

**Nestable-Inside** You can nest them inside of other things. You can’t nest anything into them.

---

\footnote{For some odd reason, \LaTeX{} allows you to fully nest both Bibliography and Abstract. Also, \LaTeX{} allows you to nest Title, Author, and Date into other environments. We urge you not to. \LaTeX{} may barf if you try it. Then again, it may not. We don’t know for certain. However, it makes no sense contextually to perform any nesting with these environments, so why would you ever want to?}
3.4.3 Nesting Other Things: Tables, Math, Floats, etc.

There are several things that aren’t paragraph environments, but which are affected by nesting anyhow. They are:

- equations
- tables
- figures

[Note: if you put a figure or a table in a Float, this is no longer true. See below or look in sections 4.3 or 4.4 for more info.]

\LaTeX{} can treat these three objects as either a word or as a paragraph. Well, you can’t inline a table, but you can inline math and figures. If a figure or an equation is inlined, it goes wherever the paragraph it’s in goes.

On the other hand, if you have an equation, figure or table in a “paragraph” of its own, it behaves just like a “nestable-inside” paragraph environment. You can nest it into any environment, but you [obviously] can’t nest anything into it.

Here’s an example with a table:

1. Item One
3.4 Nesting Environments

a) This is (a) and it’s nested.

\[
\begin{array}{cc}
a & b \\
c & d \\
\end{array}
\]

b) This is (b). The table is actually nested inside (a).

2. Back out again.

If we hadn’t nested the table at all, the list would look like this:

1. Item One

   a) This is (a) and it’s nested.

\[
\begin{array}{cc}
a & b \\
c & d \\
\end{array}
\]

   1. This is (b). The table is \textit{not} nested inside (a). In fact, it’s not nested at all.

   2. Back out again.

Notice how item (b) is not only no longer nested, but is also the first item of a new list!

There’s another trap you can fall into: nesting the table, but not going deep enough. \LaTeX\ turns anything after the table into a new [sub]list.

1. Item One

   a) This is (a) and it’s nested.

\[
\begin{array}{cc}
a & b \\
c & d \\
\end{array}
\]

   a) This is (b). The table is actually nested inside Item One, but \textit{not} inside (a).

2. Back out again.
As you can see, item (b) turned into the first item of a new list, but a new list *inside* item 1. The same thing would have happened to a figure or an equation. So, if you nest tables, figures or equations, make sure you go to the right depth!

Then there are the so-called **Floats**. A **Float** is a block of text associated with some sort of label, but which doesn’t have a fixed location. It can “float” forward or backward a page or two, to wherever it fits best. **Footnotes** and **Margin Notes** are floats, as are **Table Floats** and **Figure Floats**. When you’re editing a document in \LaTeX, a closed **Float** looks like a gray button with a red label and goes wherever the paragraph it’s in goes. However, because a **Float** has no fixed location in the final text, nesting has no effect on its actual location after you feed your document to \LaTeX.

### 3.4.4 Usage and General Features

Speaking of levels, \LaTeX can perform up to a six-fold nesting. In other words, “level #6” is the innermost possible depth. Here’s an example to display what we mean:

1. level #1 - outermost
   a) level #2
      i. level #3
         A. level #4
         • level #5
         – level #6

Once again, \LaTeX has a maximum of 6 levels, regardless of which specific paragraph environments you’re using at a given level.\(^9\) That means that you can perform a six-fold nesting of a **Description** list, or a **Verse** environment, and so on. You can also mix environments, as we shall see later.

There are two exceptions to the six-fold nesting limit, and you can see both of them in the example. Unlike the other fully-nestable environments, you can only perform a four-fold nesting with the **Enumerate** and **Itemize** environments. For example, if we tried to nest another **Enumerate** list inside of item “A.”, we’d get errors.\(^10\)

### 3.4.5 Some Examples

The best way to explain just what you can do with nesting is by illustration. We have several examples of nested environments. In them, we explain how we created the example, so that you can reproduce them.

\(^9\)Unfortunately, \LaTeX doesn’t enforce this limitation. If you try to exceed it, however, \LaTeX will return errors when you go to produce output for your document.

\(^10\)Once again, \LaTeX doesn’t enforce this limitation. If you try to exceed it, however, \LaTeX will return errors when you go to produce output for your document.
3.4.5.1 Example #1: The Six-fold Way and Mixed Nesting

#1-a This is the outermost level. It’s a List environment.

#2-a This is level #2. We created it by using M-Return followed by M-p Right.

#3-a This is level #3. This time, we just hit Return, then used M-p Right twice in a row. We could have also created it the same way as we did the previous level, by hitting M-Return followed by M-p Right.

This is actually a Standard environment, nested inside of “#3-a”. So, it’s at level #4. We did this by hitting M-Return, then M-p Right, then changing the paragraph environment to Standard. Do this to create list items with more than one paragraph - it also works for the Description, Enumerate, and Itemize environments!

Here’s another Standard paragraph, also at level #4, made with just a M-Return.

#4-a This is level #4. We hit M-Return and changed the paragraph environment back to List. Remember - we can’t nest anything inside of a Standard environment, which is why we’re still at level #4. However, we can keep nesting things inside of “#3-a”.

#5-a This is level #5...

#6-a ...and this is level #6. By now, you should know how we made these two.

#5-b Back to level #5. Just hit M-Return followed by a M-p Left.

#4-b After another M-Return followed by a M-p Left, we’re back at level #4.

#3-b Back to level #3. By now it should be obvious how we did this.

#2-b Back to level #2.

#1-b And last, back to the outermost level, #1. After this sentence, we’ll hit Return and change the paragraph environment back to Standard to end the list.

There you have it! Oh — we could have also used the Description, Quote, Quotation, or even the Verse environment in place of the List environment. The example would have worked exactly the same.
3.4.5.2 Example #2: Inheritance

This is the LyX-Code environment, at level #1, the outermost level. Now we’ll hit Return, then M-p Right, after which, we’ll change to the Enumerate environment.

1. This is the Enumerate environment, at level #2.
2. Notice how the nested Enumerate not only inherits its margins from its parent environment [LyX-Code], but also inherits its font and spacing!

We ended this example by hitting Return. After that, we needed to reset the paragraph environment to Standard and resetting the nesting depth by using M-p Left once.

3.4.5.3 Example #3: Labels, Levels, and the Enumerate and Itemize Environments

1. This is level #1, in an Enumerate paragraph environment. We’re actually going to nest a bunch of these.

   a) This is level #2. We used M-Return followed by M-p Right. Now, what happens if we nest an Itemize environment inside of this one? It will be at level #3, but what will its label be? An asterisk?

   • No! It’s a bullet. This is the first Itemize environment, even though it’s at level #3. So, its label is a bullet. [Note: we got here by using M-Return, then M-p Right, then changing the environment to Itemize.]

     – Here’s level #4, produced using M-Return, then M-p Right. We’ll do that again...

     i. . . .to get to level #5. This time, however, we also changed the paragraph environment back to Enumerate. Notice the type of numbering! It’s lowercase Roman, because we’re the thirdfold Enumerate environment [i.e. we’re an Enumerate inside an Enumerate inside an Enumerate].

     ii. What happens if we don’t change the paragraph environment, but decrease the nesting depth? What type of numbering does LyX use?

     iii. Oh, as if you couldn’t guess by now, we’re just using M-Return to keep the current environment and depth but create a new item.

     iv. Let’s use M-p Left to decrease the depth after the next M-Return.

   i. This is level #4. Look what type of label LyX is using!
3.4 Nesting Environments

i. This is level #3. Even though we’ve changed levels, \texttt{LYX} is still using a lowercase Roman numeral as the label. Why?!

ii. Because, even though the nesting depth has changed, the paragraph is still a thirdfold \texttt{Enumerate} environment. Notice, however, that \texttt{LYX} did reset the counter for the label.

b) Another \texttt{M-Return M-p Left} sequence, and we’re back to level #2. This time, we not only changed the nesting depth, but we also moved back into the twofold-nested \texttt{Enumerate} environment.

2. The same thing happens if we do another \texttt{M-Return M-p Left} sequence and return to level #1, the outermost level.

Lastly, we reset the environment to \texttt{Standard}. As you can see, the level number doesn’t correspond to what type of labelling \texttt{LYX} uses for the \texttt{Enumerate} and \texttt{Itemize} environments. The number of other \texttt{Enumerate} environments surrounding it determines what kind of label \texttt{LYX} uses for an \texttt{Enumerate} item. The same rule applies for the \texttt{Itemize} environment, as well.

3.4.5.4 Example #4: Going Bonkers

1. We’re going to go totally nuts now. We won’t nest as deep as in the other examples, nor will we go into the same detail with how we did it. [level #1: \texttt{Enumerate}]

   [\texttt{Return, M-p Right, Standard}: level #2] We’ll stick an encapsulated description of how we created the example in brackets someplace. For example, the two keybindings are how we changed the depth. The environment name is, obviously, the name of the current environment. Either before or after this, we’ll put in the level.

2. [\texttt{Return, Enumerate}: level #1] This is the next item in the list.

   Now we’ll add verse.
   It will get much worse.
   [\texttt{Return, M-p Right, Verse}: level #2]
   Fiddle dee, Fiddle doo.
   Bippity boppity boo!
   [\texttt{M-Return}]
   Here comes a table for you:

   \begin{center}
   \begin{tabular}{l|l}
   one-fish & two-fish \\
   red-fish & blue-fish \\
   \end{tabular}
   \end{center}

   [\texttt{M-Return, Table, M-p Right 3 times, M-Return, Verse, M-p Left}]
3. [Return, Enumerate: level #1] This is another item. Note that selecting a Table resets the nesting depth to level #1, so we increased the nesting depth 3 times to put the table inside the Verse environment.

We’re now ending the Enumerate list and changing to Quotation. We’re still at level #1. We want to show you some of the things you can do by mixing environments. The next set of paragraphs is a “quoted letter.” We’ll nest both the Address and Right Address environments inside of this one, then use another nested Quotation for the letter body. We’ll use M-Return to preserve the depth. Remember that you need to use C-Return to create multiple lines inside the Address and Right Address environments. Here it goes:

1234 Nowhere Rd.
Moosegroin, MT 00100
9-6-96

Dear Mr. Fizlewitz:

We regret to inform you that we cannot fill your order for 50L of compressed methane gas due to circumstances beyond our control. Unfortunately, several of our cows have mysteriously exploded, creating a backlog in our orders for methane. We will place your name on the waiting list and try to fill your order as soon as possible. In the meantime, we thank you for your patience.

We do, however, now have a special on beef. If you are interested, please return the enclosed pricing and order form with your order, along with payment.

We thank you again for your patience.

Sincerely,
Bill Hick

That ends that example!

As you can see, nesting environments in LyX gives you a lot of power with just a few keystrokes. We could have easily nested an Itemize list inside of a Quotation or Quote, or put a Quote inside of an Itemize list. You have a huge variety of options at your disposal.
3.5 Fonts and Text Styles

3.5.1 Overview

Many modern typesetting and markup languages have begun to move towards specifying character styles rather than specifying a particular font. For example, instead of changing to an italicized version of the current font to emphasize text, you use an “emphasized style” instead. This concept fits in perfectly with LyX. In LyX, you do things based on contexts, rather than focusing on typesetting details.

Right now, LyX allows you to specify a global default font, and has two character styles, Emphasized and Noun. The Emphasized style corresponds to an italics font. The Noun style corresponds to a font in smallcaps, which some languages and writing styles use to typeset proper names. The LyX Team has at last (as of LyX version 1.4) introduced true character styles, but currently these must be defined explicitly in the document layout file. There's currently no GUI support to define new, or tweak existing, character styles to allow you, the user, to customize which font changes correspond to what styles.

3.5.2 Global Options

You can set the default font from the Document > Settings dialog. There are two options of interest here, Fonts and Font Size. The possible options under Fonts include “default” and a list of fonts available on your system. The option “default” uses the standard TeX fonts, known as “computer modern” (cm) or “European modern” (ec). Most systems will typically have some version of a Times and Helvetica font, with other variants. You'll have to examine this for yourself.

As for the Font Size option, there are three possible values: 10, 11, and 12. Remember, this is the base font size. LyX actually scales all of the other possible font sizes (such as those used in footnotes, superscripts, and subscripts) by this value. You can always fine-tune the font size from within the document if you need to. It’s also rather silly to use an 8pt or 24pt font as the default font size, as this typically renders your document unreadable.

Note that once you choose a new value for Fonts or Font Size, LyX does not change the screen. You'll only see a difference once you generate the final output. This is part of the WYSIWYM concept. Besides, you have certainly noticed that "Roman" text on the LyX screen corresponds to the default font.

3.5.3 Using Different Character Styles

As we've already seen, LyX automatically changes the character style for certain paragraph environments. We also mentioned two other character styles, Emphasized and Noun. You can activate both of these styles via keybindings, the menus, and the toolbar.

To activate the Noun style, do one of the following:
• click on the toolbar button with the person-shaped icon

• use the keybinding $M-c \, c$

These commands are all toggles. That is, if **Noun** style is already active, they deactivate it.

One typically uses the **Noun** style for proper names. For example: “MATTHIAS ETTRICH is the original author of LyX.”

A more widely used character style is the **Emphasized** style. You can activate [or deactivate - it’s also a toggle] the **Emphasized** style by:

• clicking on the toolbar button with the “!” character on it

• using the keybindings $M-c \, e$

At the moment, the **Emphasized** style is equivalent to an italicized font. We have plans to make that association more user-configurable in the future.

We’ve been using the **Emphasized** style all over the place in this document. Here’s one more example:

\textit{Don’t overuse character styles!}

It’s also a warning in addition to an example. One’s writing should parallel ordinary conversation. Since we don’t all constantly scream at each other, we should also avoid the common tendency to overuse character style.

Oh — one last note: You can always reset to the default font using the keybinding $M-c \, \text{Space}$.

### 3.5.4 Fine-Tuning with the Character Layout dialog

There are always occasions when you’ll need to do some fine-tuning, so LyX gives you a way to create custom character style. For example, an academic journal or a corporation may have a style sheet requiring a sans-serif font be used in certain situations.\(^{11}\) Also, writers sometimes use a different font to offset a character’s thoughts from ordinary dialogue.

Before we document how to use custom character style, we want to issue a warning yet again: Don’t overuse character styles. Many modern word processors have a vast array of fonts available to them, providing you with the power of a printing press. Unfortunately, there is a tendency to overuse that power. The phrase, “Using a sledgehammer to swat a fly,” comes to mind. And, as the old saying implies, documents that overuse different fonts and sizes tend to look like someone’s knocked huge holes in them.

Enough complaining.

\(^{11}\)Note from John Weiss: There is, in fact, such a style sheet for the LyX Documentation, since manuals need a certain amount of consistency.
To use custom fonts, open the **Edit > Text Style** dialog. There are seven buttons on this dialog, each corresponding to a different font property which you can choose. You can choose an option for one of these seven properties, or select **No change**, which keeps the current state of that property. The item **Reset** will reset the property to whatever is the default for the hosting paragraph environment. You can use this to reset attributes across a bunch of different paragraph environments in a snap.

The seven font properties, and their options [in addition to **No change** and **Reset**] are:

### Family
The “overall look” of the font. The possible options are:

- **Roman**
  This is the Roman font family.
  It’s also the default family. [keybinding = M-c r]

- **Sans Serif**
  This is the Sans Serif font family.
  [keybinding = M-c s]

- **Typewriter**
  This is the Typewriter font family.
  [keybinding = M-c p]

### Series
This corresponds to the print weight. Options are:

- **Medium**
  This is the Medium font series.
  It’s also the default series.

- **Bold**
  **This is the Bold font series.**
  You can toggle this series on or off with the keybinding M-c b.

### Shape
As the name implies. Options are:

- **Upright**
  This is the Upright font shape.
  It’s also the default shape.

- **Italic**
  **This is the Italic font shape.**

- **Slanted**
  **This is the Slanted font shape** (although it might not be visible on screen, this is different from italic).

### Size
Alters the size of the font. You’ll find no numerical values here; all possible sizes are actually proportional to the default font size. Once again, you don’t feed LyX the details, but a general description of what you want to do.

The options [and their keybindings] are:
Tiny
This is the “Tiny” font size.
[keybinding = M-s t or M-s 1]

Smallest
This is the “Smallest” font size
[keybinding = M-s 2]

Smaller
This is the “Smaller” font size
[keybinding = M-s S or M-s 3]

Small
This is the “Small” font size.
[keybinding = M-s s or M-s 4]

Normal
This is the “Normal” font size.
It’s also the default size. [keybinding = M-s n or M-s 5]

Large
This is the “Large” font size.
[keybinding = M-s l or M-s 6]

Larger
This is the “Larger” font size.
[keybinding = M-s S-L or M-s 7]

Largest
This is the “Largest” font size.
[keybinding = M-s 8]

Huge
This is the “Huge” font size.
[keybinding = M-s h or M-s 9]

Huger
This is the “Huger” font size.
[keybinding = M-s H or M-s 0]

We’ll warn you yet again: don’t go crazy with this feature. You should almost never need to change the font size. LyX automatically changes the font size for different paragraph environments - use that instead. This is here for fine-tuning only!

Misc
Here you can change a few other things at the character level. Options are:

Emph
This is text with emphasize on.
This might seem like the same as Italic, but it is actually a bit different. If you use emphasize on italicized text, it will make it upright. In future versions of LyX, we hope to let you customize the exact behavior of this logical property.

Underbar
This is text with Underbar on.
[keybinding = M-c u]
3.6 Printing and Previewing

Noun

This is text with Noun on.

Like Emph, this is a logical attribute. For the moment, it is equivalent to Small Caps, but that is bound to change some day.

Avoid using underbar if you can! It’s a holdover from the typewriter days, when you couldn’t change fonts. We no longer need to resort to emphasizing text by overstriking it with an underscore character. It’s only included in LyX because it’s also in \LaTeX, and because some people may need it in order to follow style sheets for journal submissions (and in fact we use it in these manuals to indicate keyboard shortcuts for menu items).

Color

You can adjust the color of the text with this control. Of course, you need to have a color printer to exploit this, but you also need to have the color \LaTeX package installed. Notice that xdvi is not able to display these colors. Besides No color, which is the standard “color”, you can choose between Black, White, Red, Green, Blue, Cyan, Magenta and Yellow text.

Language

This is used to mark regions of text as having a different language from the language of the document. Text marked in this way will be underlined in blue to indicate the change.

You have a huge number of combinations to choose from.

Once you’ve chosen a new character style via the Edit Text Style dialog, you can activate it using the toolbar button labelled “Font”, or select Apply. The toolbar button lets you toggle the state of your custom character style even when the dialog isn’t visible.

As we stated earlier, to completely reset the character style to the default, use M-c Space. If you want to toggle only those properties that you have just changed (suppose you just sent the shape to “slanted” and the series to “bold”), set the Toggle on all these switch and press Apply.

We conclude with the same warning we’ve been spewing: Don’t overuse the fonts. They are, more often than not, a kludge and a horrible substitute for good writing. Your writing should speak for itself — and will.

3.6 Printing and Previewing

3.6.1 Overview

Now that we’ve covered some of the basic features of document preparation using LyX, you probably want to know how to print out your masterpiece. Before we tell you that, however, we want to give you a quickie explanation of what goes on behind-the-scenes. We cover this information in much greater detail in the Extended Features manual as well.
LYX Basics

LYX uses a program called “\LaTeX” as its backend. (Actually, \LaTeX is just a macro package for the \TeX typesetting system, but to prevent confusion, we’ll just refer to the whole magilla as “\LaTeX.”) Think of it this way: LYX is what you use to do your actual writing. Then, LYX calls \LaTeX to turn your writing into printable output. This happens in a couple of stages:

1. First, LYX converts your document to a series of text commands for \LaTeX, generating a file with the extension, “.tex”.

2. Next, \LaTeX uses the commands in the .tex file to produce printable output. It doesn’t know anything about your printer, however. Instead, \LaTeX produces what’s known as a device-independent file, or DVI for short. The actual output is in a file with the extension, “.dvi”. DVI files are completely portable; you can move them from one machine to another without needing to do any sort of conversion.

NOTE: The DVI file only contains what was in the \LaTeX file itself. If you have included PostScript pictures in your document, there will only be a link to these files. So don’t forget these files if you move your .dvi file to another computer.

3. Consider the .dvi file to be the “final output.” Once you have it, you can view it, print it, or convert it to other formats.

   a) You can view .dvi files using a program called xdvi.

   b) Some printers and Unix systems understand DVI, and can print your .dvi file directly.

   c) Nowadays, most printers understand the PostScript format. LYX automatically converts the .dvi file to a PostScript file for you when you go to print out your document. LYX will also let you preview a PostScript version of your document using the program ghostview.

One advantage of using PostScript® is that the converter program [called dvips] takes any PostScript graphics you may have included in your document and puts it into the resulting PostScript version of your document. It also includes any special fonts you may have used. That makes the PostScript version much, much more portable than the DVI version.

LYX does all of these steps automagically for you.

As you have seen, a lot of things happen before you get a hardcopy or a preview of your document. So, don’t worry if printing requires a bit more time than with other word processors. The printed result is worth the wait. Quality always has its price.
3.6 Printing and Previewing

3.6.2 Quick Viewing with xdvi

To get a look at the final version of your document, with all of the pagebreaks in place, the footnotes correctly numbered, and so on, select View DVI. Then wait a while.

When all of the behind-the-scenes action is done, L\TeX calls the program xdvi. You can now look at the results. [If you want more info on the xdvi program, see the man-pages.]

Helpful-Tip: Keep the xdvi window open, maybe moving it to another desktop. Then, after you make changes to your document, just use View Update DVI. Now click on the xdvi window. The xdvi program will automatically reread the .dvi file and give you an updated view.

3.6.3 Viewing the PostScript Version with ghostview

In general, using xdvi to view your document is the easiest and fastest way. There may be times, however, when you want to look at the PostScript version. One reason is fonts.\footnote{Note from John Weiss: Another reason is paranoia. I always like to look at the PostScript file before I print it, just so I see exactly what went to the printer...} You can use PostScript fonts in a \LaTeX document, but xdvi won’t show this. You’ll need to use ghostview or some other PostScript file viewer to see the actual results.

To view the PostScript version of your document, select PostScript from the View menu. When all of the magic behind-the-scenes is done, L\TeX calls the program ghostview. You can now look at the results.

You’ve guessed what the Update Postscript command from the View menu does, haven’t you? Remember to click once in the ghostview window after this command to update the view.

3.6.4 Printing the File

To print a file, select Print from the File menu, or click on the toolbar button with the printer on it. This opens the Print dialog.

You can choose to only print even-numbered or odd-numbered pages - this is useful for printing on two sides: you can re-insert the pages after printing one set of pages, to print on the other side. Some printers spit out pages face-up, others, face-down. By choosing a particular order to print in, you can take the entire stack of pages out of the printer without needing to reorder them.

You can set the parameters in the Destination box as follows:

\begin{itemize}
  \item \textbf{Printer} This is the name of the printer to print to.\footnote{Note that this printer name isn’t for the \texttt{lpr} command but for \texttt{dvips}. That means \texttt{dvips} has to be configured for this printer name. See the section 2.5.2 or the \texttt{dvips} documentation for details. The default printer can also be set in \texttt{lyxrc}.} The printer should understand PostScript files.
\end{itemize}
3 \LaTeX\ Basics

**File** The name of a file to print to. The output will be in PostScript format. The file will generally be written in the current directory, unless you specify the full path.

Note that printing may need little time, since \LaTeX, \texttt{dvips} and, if you don’t have a PostScript printer, \texttt{ghostscript} have to process your document.

### 3.7 A Few Words about Typography

#### 3.7.1 Hyphens and Hyphenation

In \LaTeX, the “–” character comes in three lengths, often called the *hyphen*, the *en dash*, and the *em dash*:

1. hyphen - made with “–”
2. en dash – made with “—”
3. em dash — made with “——”
4. minus sign \( - \) a “–” in math mode

You generate these by using the “–” character multiple times in a row. \LaTeX\ automatically converts them to the appropriate length dash in the final output.

The three types of dash are distinct from the minus sign, which appears in math mode and has a length of its own. Here are some examples of the “–” in use:

1. line- and page-breaks \( (\text{hyphen}) \)
2. From A–Z \( (\text{en dash}) \)
3. Oh — there’s a dash. \( (\text{em dash}) \)
4. \( x^2 - y^2 = z^2 \) \( (\text{minus sign}) \)

Those of you reading this from within \LaTeX\ will see no difference, though there is one in the printed version.

One more note about hyphenation — \LaTeX\ automatically breaks up words and inserts hyphens in English text. The words won’t be hyphenated until you generate the final output.

Actually, it’s \LaTeX\ that does this, and it will also hyphenate words in *some* other languages. To know whether (PDF)\LaTeX\ hyphenates for *your* language, look at any log file produced by a \LaTeX\ run: it will say

*Babel <v3.7h> and hyphenation patterns for american, french, german, ngerman, nohyphenation, loaded.*
3.7 A Few Words about Typography

This tells you that, e.g., if you write in Finnish, you’re out of luck. Study (for the \TeX{} distribution of \LaTeX{}) the utilities \texttt{texconfig} and \texttt{fmtutil} in order to switch hyphenation on for your language by “uncommenting” the relevant line in a file typically named \texttt{language.dat}. Sorry for the inconvenience.

If, for whatever reason, \LaTeX{} still can’t break a word correctly (e.g., a compound word), you can set hyphenation points manually. This is done with the menu item Hyphenation Point under Special Formatting in the Insert menu. Note that these extra hyphenation points are only recommendations to \LaTeX{}. If no hyphenation is necessary, \LaTeX{} will totally ignore them.

3.7.2 Punctuation Marks

3.7.2.1 Abbreviations and End of Sentence

When \LaTeX{} calls \TeX{} to generate the final version of your document, \TeX{} automatically distinguishes between words, sentences, and abbreviations. \TeX{} then adds the “appropriate amount of space”: sentences get a little bit more space between the period and the next word. Abbreviations get the same amount of space after the period as a word uses.

Unfortunately, the algorithm for figuring out what’s an abbreviation and what’s the end of a sentence is really quite brain-dead. If a “.” is at the end of a lowercase letter, it’s the end of a sentence; if it’s at the end of a capitalized letter, it’s an abbreviation.

Here are some examples of correct abbreviations and the end of a sentence:

- M. Butterfly
- Don’t worry. Be happy.

...and here’s an example of the algorithm going wrong:

- e. g. this is too much space!
- This is I. It’s okay.

You won’t see anything wrong until you view a final version of your document.

To fix this problem, use one of the following:

1. Use an Inter-word Space after lowercase abbreviations (see section 6.6.5.1).
2. Use a Thin Space between two tokens of an abbreviation (see section 6.6.5.3).
3. Use an End of sentence period found under the Insert \Special Character menu to force the use of inter-sentence spacing. This function is also bound to C-period for easy access.

With the corrections, our earlier examples look like this:
3 \LaTeX Basics

- e.g. this is too much space!
- This is I. It’s okay.

Some languages don’t use extra spacing between sentences. If your language is such a language, you don’t need to worry about all of this. For those that do need to bother, there is help to catch those sneaky errors: check out the Tools→Check \TeX feature described in Extended Editing.

3.7.2.2 Quotes

\LaTeX usually sets quotes correctly. Specifically, it will use an opening quote at the beginning of quoted text, and use a closing quote at the end. For example, “open close”. The keyboard character, ", generates this automatically.

**New in version 1.4:** To get single quotation marks, you have to press C-". This produces quotation marks like this: ‘’.

You can also select quotes for different languages via the Type option. There are six choices:

- "Text" Use quotes like this “double” or ‘single’
- "Text" Use quotes like ”this” or ‘this’
- „Text“ Use quotes like „this“ or ,this’
- „Text“ Use quotes like „this” or ,this’
- «Text» Use quotes like «this» or ‹this›
- »Text« Use quotes like »this« or ›this‹

Again, this affects what character the " key produces.

On the other hand, if you want to produce a bona-fide quote character, type M-". This produces: ".

3.7.3 Ligatures

It is standard typesetting practice to group certain letters together and print them as single characters. These groups are known as ligatures. Since \TeX knows about ligatures, your \LaTeX documents will contain them, too. Here are the possible ligatures:

- ff
- fi
- fl
- ffi
3.7 A Few Words about Typography

- \( \text{lfl} \)

Once in a while, though, you don’t want a ligature in a word. While a ligature may be okay in the word, “graffiti,” it looks really weird in compound words, such as “cufflink” or the German “Dorffest.” To break a ligature, use \text{Insert} \rightarrow \text{Special Formatting} \rightarrow \text{Ligature Break}. This changes “cufflinks” to “cuff‌links” and “Dorffest” to “Dorf‌fest”.

3.7.4 Widows and Orphans

In the early days of word processors, page breaks went wherever the page happened to end. There was no regard for what was actually going on in the text. You may remember once printing out a document, only to find the heading for a new section printed at the very bottom of the page, the first line of a new paragraph all alone at the bottom of a page, or the last line of a paragraph at the top of a new page. These dangly-bits of text became known as \text{widows} and \text{orphans}.

Clearly, \LaTeX\ can avoid breaking pages after a section heading. That’s part of the advantage of paragraph environments. But what about widows and orphans, where the page breaks leave one line of a paragraph all alone at the top or bottom of a page? There are rules built into \LaTeX\ governing page breaks, and some of those rules are there to specifically prevent widows and orphans. This is the advantage \LaTeX\ has in using \LaTeX\ as its backend.

There’s no way we can go into how \TeX\ and \LaTeX\ decide to break a page, or how you can tweak that behavior. Some \LaTeX\ books listed in the bibliography [such as [3] or [4]] may have more information. You will almost never need to worry about this, however.
4 Floats: Tables, Figures, Footnotes and Margin Notes

4.1 Footnotes

Unlike other typesetting programs, LyX uses “foldable” boxes instead of displaying its footnotes at the bottom of the screen or somewhere else in your text. When you insert a footnote with Insert △ Footnote, you’ll first see a grey box with a red label “foot” appearing within your text. This box is LyX’s representation of your footnote. You can enter your text into this box. If you click the “foot” label, the box will “fold”. Clicking on the button again will “unfold” the footnote.¹ You will not see any numbers within LyX. You don’t need to worry about those, anyhow, because LyX does the numbering for you, as well as putting the footnote at the bottom of the correct page, when it processes your file. If you want to turn already existing text into a footnote, simply mark it and click on the footnote button (a picture of text with an arrow pointing to stuff in the bottom margin).

What LyX cannot do, yet, is take care of special needs like setting the footnote numbering back to 1 after each section in the “article” document class or changing the counter style. You’ll need to insert \LaTeX commands like those described in the Tricks for Footnotes and Marginpars section of “Extended Features.”

NOTE: A float in \LaTeX and LyX isn’t a simple paragraph as with usual word processors. It is a complex text structure that may contain everything except floats. That means you can use all the layouts inside a float, even figures and tables. You may not need this too often, but if you do occasionally need it, it’s a neat feature.

4.2 Margin Notes

Margin notes look and behave just like footnotes in LyX. When you insert a margin note via Insert △ Margin Note or the toolbar button (which contains a picture of text in a margin with an arrow pointing to it), you’ll see a grey box with a red label “margin” appearing within your text. This box is LyX’s representation of your margin note. You can enter your text into this box. If you click the “margin” label, the box will “fold”. You can access it at a later time by clicking on the label again, thereby “unfolding” the margin note.

¹To close this footnote, click on the red box at the top left.
As a default, \LaTeX{} uses 1.9 cm (0.75 inches) as the margin width to allow room for margin notes. This might not be what you’re looking for, but as with footnotes, \LaTeX{} cannot yet do everything \TeX{} has to offer. You might want to consult your \TeX{} handbook for additional commands.

### 4.3 Figures and Imported Graphics

No document preparation system is complete without the ability to import graphics from other utilities into the document. In \LaTeX{}, these are referred to as “figures” whether they are actually figures in the traditional sense or simply some kind of imported image.

Note that figures referred to here are do not have captions and sit wherever in the document you place them. If you need one of these features, see sec. 4.3.2.1 below.

To place a figure in your document, click on the second right-most icon on the toolbar, or select Insert $\triangleright$ Graphics... from the menu.

A dialog will appear for you to choose the file to load. You can also change any settings you need to in this dialog.

![Figure](image.png)

This dialog has numerous parameters, though most should be self-explanatory. The File tab allows you to choose your image file (note that a wide variety of image formats are supported automatically). The figure can be transformed by setting a rotation angle, using a bounding box, and scaling. Table 4.1 describes all available units. It is possible to set a bounding box automatically for some image formats (see the Bounding Box tab). Note that it is possible to control the display of the figure in \LaTeX{} and the display in the final document separately, which can be very useful for large figures. \TeX{} wizards can specify additional \TeX{} options in the Extras tab. You can also set the Subfigure option here, for use in figure floats (see Section 4.3.2.1).

#### 4.3.1 How it works

\LaTeX{} has the ability to handle literally any graphics format in the known universe so long as a conversion path from this graphics format to the target output format can be created. If that sounds a little obtuse, consider how \LaTeX{} handles Encapsulated PostScript® figures. \TeX{} provides native support for this format, so \LaTeX{} needs do
Table 4.1: Units for setting the image size

<table>
<thead>
<tr>
<th>unit</th>
<th>name/description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td>millimetre</td>
</tr>
<tr>
<td>cm</td>
<td>centimetre</td>
</tr>
<tr>
<td>in</td>
<td>inch</td>
</tr>
<tr>
<td>pt</td>
<td>point (72.27 pt = 1 in)</td>
</tr>
<tr>
<td>pc</td>
<td>pica (1 pc = 12 pt)</td>
</tr>
<tr>
<td>sp</td>
<td>scaled point (65536 sp = 1 pt)</td>
</tr>
<tr>
<td>bp</td>
<td>big point (72 bp = 1 in)</td>
</tr>
<tr>
<td>dd</td>
<td>didot (72 dd ≈ 37.6 mm)</td>
</tr>
<tr>
<td>cc</td>
<td>cicero (1 cc = 12 dd)</td>
</tr>
<tr>
<td>Scale%</td>
<td>% of original image width</td>
</tr>
<tr>
<td>text%</td>
<td>% of text width</td>
</tr>
<tr>
<td>col%</td>
<td>% of column width</td>
</tr>
<tr>
<td>page%</td>
<td>% of paper width</td>
</tr>
<tr>
<td>line%</td>
<td>% of line width</td>
</tr>
<tr>
<td>theight%</td>
<td>% of text height</td>
</tr>
<tr>
<td>pheight%</td>
<td>% of paper height</td>
</tr>
<tr>
<td>ex</td>
<td>height of letter $x$ in current font</td>
</tr>
<tr>
<td>em</td>
<td>width of letter $M$ in current font</td>
</tr>
<tr>
<td>mu</td>
<td>math unit (1 mu = 1/18 em)</td>
</tr>
</tbody>
</table>

nothing other than use the \includegraphics \LaTeX command to insert the figure in the final document.

To view the figure on the \LaTeXX screen, however, some additional work is required because neither the XForms nor the Qt GUI libraries can load PostScript® figures themselves. The XForms library can load figures in the following, widely used graphics formats: \texttt{bmp, gif, jpeg, pbm, pgm, ppm, tif} and \texttt{xbm} whilst the Qt library can also handle \texttt{mng, png} and \texttt{xpm} format figures. Thus, \LaTeXX must initiate a conversion from Encapsulated PostScript® to a loadable graphics format.

It does this using the powerful, configurable converters mechanism exposed in the Converters section of the \textit{Edit} > Preferences dialog. If \LaTeXX cannot create a conversion path (which might have many steps) from Encapsulated PostScript® to one of the loadable formats listed above, then it defaults to the use of ImageMagick’s \texttt{convert} utility. If, after all that, \LaTeXX still cannot load the figure, then it’ll tell you so with a message “Error converting to loadable format” in place of an on-screen view of your figure. If you’re presented with such a message, then you’ll need to augment the list of known converters.

This strategy is used both to generate on-screen views of your image and when generating the final document. In the latter case, the \LaTeX compiler must be supplied with graphics files in PostScript® format. Similarly the PDF\LaTeX compiler requires
files in pdf, png or jpeg format. \LaTeX{} will handle the necessary conversions behind the scenes.

**4.3.2 Figure Floats**

**4.3.2.1 Using Figure Floats**

The problem with inserting figures straight into your text is that they might make the pagination of your document extremely awkward. To suit the \LaTeX{} mentality of automating such processes, you might find it preferable to use **Figure Floats**, which \LaTeX{} (actually, \TeX) is free to move about your document as it deems necessary for a good fit. In return, \LaTeX{} automates the listing of these figures and allows you to place a caption on them, using the **Caption** environment explained in Section 3.3.9.1.

To place a **Figure Float** simply select **Insert**\(\rightarrow\) **Float**\(\rightarrow\) **Figure** from the menu bar. You will get a float without a figure in it; use the toolbar icon described above to insert the actual figure.

![M.C. Escher on acid](image)

**Figure 4.1**: M.C. Escher on acid.

It seems simple, but there is subtlety involved in the placement of the caption. If you prefer your caption to appear below the figure, then you must press return when the cursor is at the very start of the caption, and insert the figure in the new paragraph created above the caption; or you can delete the caption and recreate it by selecting the **Caption** environment after the figure has been inserted. This is what we did for figure 4.2. If the cursor is in a paragraph after the caption when you insert the **Figure** then it will be inserted after the caption, as was the case for 4.1. It is preferred to use one **Figure** per **Float**. This allows \LaTeX{} [actually \TeX] to best position each figure.

Right-clicking on a float opens a dialog where you can alter the placement options that \TeX uses for positioning the float (see 4.3.2.2). **Span columns** is only useful for
Figure 4.2: A severely distorted platypus in a float.
two-column documents: if you select it, the float will span across both columns on the page instead of being confined to just one.

This figure also shows how we place a label and create a cross-reference to it; as you would expect from reading section 6.1 you can simply insert a Label in the caption and refer to it using a Cross Reference as normal. It is especially important to use these with figure floats, rather than using vague references to “the above figure,” as \LaTeX{} will reposition your floats for you in the final document; it might not be “above” at all. If it is not possible to fit the floats neatly on the same page as the text which refers to it, the figures will be placed on a separate page by themselves. Rest assured that the overall effect is usually quite nice.

Note that the caption is used in a List of Figures (as described in Section 4.5.2) automatically, should you choose to include one in your document.

4.3.2.2 Float Placement

Now, the whole idea behind Figure Floats [as well as Table Floats, which we introduce later] is to allow \LYX{} to place a figure [or table] on a page in a consistent, sensible fashion. The rules \LaTeX{} uses are rather arcane; refer to the \LaTeX{} documentation for the exact details. You can use check boxes in the float dialog to set placement for a particular float. By default, each float uses the document’s default placement rules. You can change these, if you wish, in the Document Settings dialog. The Float placement box takes a \LaTeX{}-style placement specification. You can place any combination of four letters in the Float placement box, in any order:

- h for here
- t for top
- b for bottom
- p for page

The letters correspond to the following behaviour:

**Here:** \LYX{} tries to put the Float at the same point in the text where you put it. If there isn’t enough room, \LYX{} tries one of the other three location types.

**Top:** \LYX{} tries to put the Float at the top of the current page. If the figure won’t fit on the current page, it goes to the next page.

**Bottom:** \LYX{} tries to put the Float at the bottom of the current page. If there isn’t room, it goes to the next page.

**Page:** \LYX{} tries to put the Float (or a number of Floats) on a page of its own.
There is some subtlety to how this all works. The order specifies what location \LaTeX should try first. If that one fails, it tries the next one, and so on, though “h” will always take precedence if it appears in the list. The default placement list is “tbp”: try the top of a text page first, then the bottom of a text page, then on a page by itself. If you want \LaTeX to try “really hard” to place the figure where you command it, precede the list with an exclamation point; for example “!htbp”. Here are some example entries and what they do:

1. hbp
   Try putting the figure/table at its actual position in the text. If that doesn’t work, put it on the bottom of the page. If that fails, put it on a separate page.

2. !hbp
   Try really hard to put the figure/table at its actual position in the text. Then the bottom of the page, then on a separate page.

3. tp
   Put the figure/table at the top of each page. If it’s too long, put it on a separate page.

4. p
   Always put figures and tables on their own page.

4.3.3 \texttt{XFig} and \LaTeX

One obvious question is “how would I create the figures?” Fortunately, the answer is included in most Linux and/or \LaTeX distributions. \texttt{XFig} is a powerful though slightly awkward drawing tool. If you want to include figures that you have created with \texttt{XFig} there are several ways. We recommend the following:

1. Export the figure as Encapsulated PostScript. This could be very easy included into \LaTeX as described in the previous sections. The great advantage of this way is, that you have the full power of PostScript® available. That means Bezier curves, colors, all line thicknesses and many more. If you have inserted text into your fig-document this will be printed with PostScript fonts, which is OK. The figure can be manipulated like any other EPS figure, as described above. The only disadvantage is that you cannot create formulas as PostScript text except by hand. If you also need formulas or simple exponents or indices in your figure, the next way is recommended.

2. Export the figure as \LaTeX. This is just as easy to include into \LaTeX, with the advantage that you may use all \LaTeX commands within the text inside \texttt{XFig}. Therefore you have to set the \texttt{special flag} for text in \texttt{XFig}. This is automatic if you invoke \texttt{XFig} with \texttt{xfig -specialtext}. If this is done and you have also
chosen a \LaTeX font you may simply write \textquotedblleft H$_2$\textquotedblright in XFig. If you export this figure as \LaTeX and include it in \LaTeXX with Insert \textgreater Child Document (see description in Extended Features) this text will appear as $H_2$.

The disadvantage of this way is that the graphical power of \LaTeX isn't as strong as PostScript\textregistered. You cannot use all thicknesses of lines and, more annoyingly, not all slopes. This is why we recommend the third way for more complex figures.

3. Export the figure as \LaTeX/PostScript combined. Then XFig [transfig, really] will generate two files:

a) the PostScript part \texttt{foo.pstex}, that contains all painting.

b) the \LaTeX part \texttt{foo.pstex_t}, that contains all text and a link to the PostScript part.

Then you just have to include the \LaTeX part as described above. This will automatically include the PostScript part, too.\textsuperscript{2} This way you have the full PostScript\textregistered and \LaTeX power combined except for the possibility to scale the figure after creating. So if you want scalable pictures, the PostScript format is your only choice. Another little advantage of letting \LaTeX typeset the font is that the same font will appear in your figures as in your text, which looks a little nicer.

### 4.4 Tables

\LaTeXX has powerful table support, but \LaTeX can do many more things with tables than \LaTeXX is currently capable of, so you might want to look at a good \LaTeX book if the features described here should turn out to be inadequate.

You can insert a table using either the table toolbar button or Insert \textgreater Table. A dialog will appear, asking you for the number of rows and columns. The default table has lines at the top and to the left of every cell, a line to the right of the rightmost column and a line at the bottom of the lowest row, forming a box around the table. Additionally, the topmost row also has a line at the bottom, which causes this row to appear separated from the rest of the table. Here's an example:

\begin{verbatim}
\begin{table}
\begin{tabular}{|c|c|c|}
\hline
A & B & C \\
\hline
1 & 2 & 3 \\
\hline
\end{tabular}
\end{table}
\end{verbatim}

\textsuperscript{2}If you get an error like “unknown graphics extension pstex” you have to declare these graphic extensions. I think this is a transfig bug that occurs with \LaTeX\textsuperscript{2e}. Simply add a line like

\begin{verbatim}
\@namedef{Gin@rule@ps_tex}#1\{{eps}{ps_tex}{#1}}
\end{verbatim}

in the file /usr/lib/texmf/tex/latex/dvips.def. Then add pstex to the extension:

\begin{verbatim}
\def\Gin@extensions{eps, ps, pstex, eps.gz, ps.gz, eps=2EZ}
\end{verbatim}

This should fix the whole thing. Alternatively you may export the PostScript part as \texttt{foo.eps} and change the \LaTeX part \texttt{foo.pstex_t} manually. But this is annoying.
4.4 Tables

4.4.1 The Table dialog

You can alter a table by clicking on it with the right mouse button, which brings up a settings dialog. Among these options are:

- Adding/removing border lines from a row or column. If you remove the top line from one of the rows, you’ll get a dotted line in LyX, but no line will appear in the printout. If you set the bottom line of one row and the top line of the row below, then the rows are separated by a small space, as you can see with the top row in the example above. You can do the same vertically if you set the right line of a column and the left line of the column to the right.

- Text alignment in a column

- Appending rows and columns

- Deleting rows, columns, or the entire table

- Multicolumn

- Setting a fixed width for a column

- Longtable options - this is useful if your table is higher than the paper. Then the table is split on the bottom of the page and continued on the next one, instead of running off the end of the page.

- Rotate the whole table or a single cell sideways, by 90 degrees

You can also use the menu to perform these operations. Try \texttt{Edit} -> \texttt{Table} or \texttt{Edit} -> \texttt{Rows&Cols} when the cursor is inside a table.

Most of these options also work on selections. This means that if you select more cells, columns or rows the action is done on all of your selection. Note that there is a difference between selecting the contents of the cell, and the cell itself. If you can see a red border inside a cell, then a selection will select the contents. If you press \texttt{Escape} or click outside of the box, then the selection will select cells (whether you use the mouse or the normal cursor-movement keys).

When you append a row, it is added below the row containing the cursor. Similarly, columns are appended to the right of the cursor. This makes it difficult to add columns on the left edge of a table without a lot of cutting and pasting. Deletion is always performed on the row or column containing the cursor.

The multicolumn option merges two or more adjacent cells on a given row. For example, in the above table, row “B” has had multicolumn applied to the columns.
4 Tables, Figures, and Notes

labelled “45” and “98.” To use it, you must first select the cells, then choose Multicolumn from the menu. This will not work vertically - see the Table Examples document for how to do this.

You can also use Multicolumn if you need to have a special handling for a single table cell’s top and bottom border lines and text alignment. Here an example of this special handling of a cell:

<table>
<thead>
<tr>
<th>*</th>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>point a &amp; b</td>
<td>103</td>
<td>9</td>
</tr>
<tr>
<td>point b &amp; a</td>
<td>599</td>
<td>340</td>
</tr>
<tr>
<td>point abc</td>
<td>1009</td>
<td>52</td>
</tr>
<tr>
<td>point abcd</td>
<td>96</td>
<td>11</td>
</tr>
</tbody>
</table>

You see here that the header line cells are aligned to the center, whereas the left column is aligned to the left, and the other columns are aligned to the right. Also the bottom and top line of two cells have been removed.

If you want your column to have a fixed width, then you can insert a width in the Width input-field of the Table dialog. This will then allow the cell to have multiple paragraphs of text.

If your table becomes too large to fit on a portrait document layout, you can select the Rotate 90° button, and the table will appear sideways (this means landscape in a portrait document style). You might also like to rotate single table cells to give them more horizontal space. The example below demonstrates why it is useful to rotate single cells.

**Note:** This Rotate 90° option will not display on screen, and works only for PostScript output. So, if you want to preview them, use View Postscript, as View DVI will not show the table properly.

<table>
<thead>
<tr>
<th>Description</th>
<th>Flag 1</th>
<th>Flag 2</th>
<th>Flag 3</th>
<th>Flag 4</th>
<th>Flag 5</th>
<th>Flag 6</th>
<th>Flag 7</th>
<th>Flag 8</th>
<th>Flag 9</th>
<th>Flag 10</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desc. 1</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>7</td>
</tr>
<tr>
<td>Desc. 2</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>9</td>
</tr>
<tr>
<td>Desc. 3</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>8</td>
</tr>
<tr>
<td>Desc. 4</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>6</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
</tr>
</tbody>
</table>

4.4.2 What can be placed inside a table cell?

Many objects can be placed inside a table cell. Any single line of text, an equation (not a displayed or multilined equation, though), or a figure can be in a cell; in fact, all three kinds of objects can be placed in the same cell. Font sizes and shapes can be altered, and the table will adjust to display them properly. However, you can’t put a special environment in a cell (like Section*, etc.), nor set spacing options etc. for the cell’s paragraph.
4.4.3 Cut & Paste in Tables

Cutting and pasting between tables works reasonably well. You can cut and paste even more than one row. Selection with the mouse or with Shift plus the arrow keys works as usual. The values in the second table below were cut and pasted from the first, using the mouse to select and paste.

```
  | 1 | 2 | 3 |
---|---|---|---|
1 | 4 | 5 | 6 |
2 | 7 | 8 | 9 |
```

Note that you can also copy and paste the entire table as a single unit by starting the selection from outside the table.

4.4.4 Multiple lines in cells

It is possible to have multi-line entries in tables, but not in a completely WYSIWYM manner. Define a fixed length for the column in the Table dialog. After this, your text is automatically split into more lines and the cell enlarged vertically when the length of the text exceeds the given fixed length. An example:

```
1  | 2 |
---|---|
4  | This is a multi-line entry in a table. |
6  | This is longer now. |
8  | This is a multi-line entry in a table. This is longer now. |
```

Text within a cell will not normally wrap to fit the page, so if a line of text in a table is too long, the table will extend beyond the right margin of the page. Similarly, tables will not split themselves at the bottom of a page, and so might extend below the bottom margin. You have these options to resolve this problem:

1. Split it into two tables.

2. Select the Longtable button in the Table dialog. This automatically splits the table over more pages, if it is too tall. After doing this, the list of Longtable buttons activate themselves and you may now define:
4 Tables, Figures, and Notes

a) First header: The current row and all rows above that don’t have any special options defined are defined to be the header rows of the first page of the longtable.

b) Header: The current row and all rows above that don’t have any special options defined are defined to be the header rows of all pages of the longtable; except for the first page, if First header is defined.

c) Footer: The current row and all rows below that don’t have any special options defined are defined to be the footer rows of all pages of the longtable; except for the last page, if Last footer is defined.

d) Last footer: The current row and all rows below that don’t have any special options defined are defined to be the footer rows of the last page of the longtable.

If you set more than one option in the same table row, you should be aware of the fact that only the first flag is used in the given table rows. The others will then be defined as empty. In this context, first means first in this order: Footer, Last footer, Header, First header. See the TableExamples.lyx example file to see how this works.

The check box in the long table options can be used to specify specific rows to break the page on as well.

3. A table can also be placed in a float, as described below, which will allow \LaTeX to place it as well as it can within the page.

4.4.5 Table Floats

Outside of a float, the table will be positioned exactly where it is placed in the document. Using a Table Float from the Insert ⊲ Float menu will enable \LaTeX to place the table where it fits best, rather than exactly where you insert it. Float placement for table floats is similar to that for figure floats 4.3.2.1, and is described in section 4.3.2.2. Captions also work the same way as with figure floats, as described in section 4.3.2.1. Table 4.2 is an example of a table float.

<table>
<thead>
<tr>
<th>Table 4.2: A table float.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>Joe</td>
</tr>
<tr>
<td>∫x²dx</td>
</tr>
<tr>
<td>1 + 1 = 2</td>
</tr>
<tr>
<td>c</td>
</tr>
</tbody>
</table>
4.5 Table of Contents and other Listings

One of the really nice features of \LaTeX{} is the ease with which it lets you create various “Lists,” such as a Table of Contents. All you need to do is to use certain environments and insert a reference at the place where you want the list to appear.

4.5.1 The Table of Contents

In order to get a Table of Contents, you need to do four things:

1. Use a document class that includes support (all but \texttt{letter}).

2. Set paragraph environments appropriately: \texttt{Chapter}, (Sub...) \texttt{Section}, (Sub...), \texttt{Paragraph}. Note that styles with a *, like \texttt{Section*}, will \texttt{not} appear in the Table of Contents.

3. Make sure you set the \texttt{Section number depth} and \texttt{Table of contents. depth} in the \texttt{Document Layout} dialog to the appropriate value as described in 3.3.4.3.

4. Insert the ToC command at some place in the document. You’ll find it under \texttt{Insert} \texttt{List / TOC} \texttt{Table of Contents}.

You can also bring up a dialog for navigating through your document with \texttt{Document} \texttt{Table of Contents}.

4.5.2 List of Figures, Tables and Algorithms

Table, figure, and algorithm lists are very much like the table of contents. You can insert them from the \texttt{Insert} \texttt{List / TOC} submenu. If you want figures, tables, or algorithms to appear in the list, you must place them inside a float of the relevant type and add a caption.
4 Tables, Figures, and Notes
5 Mathematical Formulae

5.1 Basic Math Editing

To create a math formula, you can just click on the toolbar icon with $\frac{a+b}{c}$ on it. That will open a little blue square, with purple markers around it, on the corners. That blue square is the formula itself; the purple markers indicate what level of nesting within the formula you are at. You can also choose a particular formula type to insert via the Insert $\rightarrow$ Math menu; or you can use a keyboard macro, M-c m, M-m m, or C-m (CUA binding only).

If you simply need to type a single Greek letter, such as $\alpha$, there is a special shortcut. Just type M-m g a to get $\alpha$, M-m g b to get $\beta$, etc.

Editing the parameters of a formula may be done from the Insert $\rightarrow$ Math $\rightarrow$ Math Panel dialog, by Edit $\rightarrow$ Math, or by clicking the right mouse button on the formula. The math panel is very useful, so you may want to open it and leave it somewhere on the screen. If you’re not already in a formula, selecting anything from the math panel will insert a formula for you.

5.1.1 Navigating a Formula

The best control over cursor position within an existing formula is achieved with the arrow keys. Mathed uses small squares to indicate places where something can be inserted. The arrow keys can be used to navigate between parts of a formula. Pressing Space will leave a fraction or other formula construct (a square root $\sqrt{2}$, or parentheses $(f)$, or a matrix $\begin{bmatrix} 1 & 2 \\ 3 & 4 \end{bmatrix}$). Pressing Escape will leave the formula, placing the cursor after the formula. Tab can be used to move horizontally in a formula; for example, through the cells of a matrix or the positions in a multi-line equation.

Space seems to do nothing in Mathed, since it does not in fact add a space between characters, but it does exit a nested structure. For this reason, you have to be careful about using Space. For example, if you want $\sqrt{2x+1}$, type \sqrt then Space, then 2x+1, not \sqrt Space 2x Space + Space 1, since in the latter case only the 2x will be under the square root sign, $\sqrt{2x + 1}$. For those who learned to space out expressions in this way, it takes a little unlearning.

You can leave many parts of a formula, like this matrix, partially filled in, such as:

$$\begin{pmatrix} \lambda_1 \\ \vdots \\ \lambda_n \end{pmatrix}$$
If you leave a fraction only partially filled in, or a subscript with nothing in it, the results will be unpredictable, but most constructs don’t mind.

5.1.2 Selecting Text

You can select text within a formula in two different ways. Place the cursor at one end of the string of text you want, and press Shift and a cursor movement key to select text. It will be highlighted as with regular text selection. Alternatively, you can select text with the mouse in the usual way. That text can then be cut or copied, and then pasted within any formula (not in a plain text region in LYX, though).

5.1.3 Exponents and Subscripts

You can use the math panel to add superscripts or subscripts, but the much easier way is to use the standard TeX method. To get $x^2$, type (in Mathed) \texttt{x}\textsuperscript{2} then \texttt{Space}. The final \texttt{Space} puts the cursor back down on the base line of the expression, instead of in the superscript. If you type \texttt{x}\textsuperscript{2}y, you will get $x^2y$, to get $x^2y$, type \texttt{x}\textsuperscript{2} then \texttt{Space} then \texttt{y}. Subscripts are similar, to get \texttt{a}_1, type (in Mathed) \texttt{a}_1 then \texttt{Space}. Note that by default, the superscript or subscript is only for the single symbol to the left, which changes the spacing and alignment; you should read section 5.3 if you need to alter this.

5.1.4 Fractions

Create a fraction with either \texttt{\frac} (in Mathed) or using the fraction icon in the Math Panel dialog or the Math menu item Fraction. You will be presented with an empty fraction, with two Mathed insertion squares top and bottom. The cursor moves immediately to the top of the fraction. To move to the bottom, simply press Down. To move back up, press Up. Any math structure can be placed in a fraction, as this example shows:

$$\left[ \frac{1}{2 3 4 5} \right]$$

5.1.5 Sums and Integrals

Sum ($\sum$) and integral ($\int$) signs are very often decorated with one or more sets of “limits”. These limits can be entered in LYX by entering them as you would enter a superscript or subscript, directly after the symbol. Sum will automatically place its “limits” over and under the symbol in display style, but will move them to the side when inlined, such as $\sum_{n=0}^{\infty} \frac{1}{n!} = e$, versus

$$\sum_{n=1}^{\infty} \frac{x^n}{n} = \ln \left( \frac{1}{1-x} \right).$$
Integral signs, however, will not by default move the limits to directly over and under the integral sign in display style, as in $\int_a^b f(t) \, dt := F(x)$, versus

$$\int_{-\infty}^{\infty} \frac{dx}{1+x^2} = \pi.$$ 

Both symbols will be automatically re-sized when placed in display mode. In display mode, the placement of the limits (directly above and below, or offset to the right from the sign) can be changed by placing the cursor in front of the sign and hitting \texttt{M-m l}. Exactly what change occurs depends on the sign.

Certain other mathematical expressions have this “moving limits” feature as addition, such as

$$\lim_{x \to \infty} f(x),$$

which will place the $x \to \infty$ underneath the “lim” in display mode, but not in inlined mode, $\lim_{x \to \infty} f(x)$. Note that the lim was entered as a function - you get it in \LaTeX by typing \texttt{\LaTeX{lim}} in math-mode, or choosing from the “functions” menu in the math panel; see 5.1.9.

### 5.1.6 The Math Panel

The Math Panel dialog (accessible via Insert $\triangledown$ Math) has a more extensive list of symbols and structures. As stated earlier, you can keep the math panel open when writing mathematics. The use of the panel should be fairly obvious; we’ll describe some of the details in later sections.

Note that right-clicking on a formula opens the panel as well.

### 5.1.7 Other Math Symbols

Most math symbols can be found in the math panel under one of several categories; including \texttt{Greek $\Gamma$reek}, \texttt{operators $\pm \times$}, \texttt{relations $\leq \approx$}, \texttt{arrows $\uparrow \iff$}, \texttt{large operators $\sum \int$}, and the dreaded \texttt{miscellaneous}. There are also the additional symbols provided by the American Mathematical Society (AMS). If you know the standard \LaTeX macro for a particular symbol you which to use, you do not have to use these dialogs, but they will help for those symbols whose \LaTeX name you do not know. Note that the AMS symbols will not be displayed as symbols in \LaTeX unless you install the right fonts as described in the relevant manual.

It is possible to get an nth root symbol. In the minibuffer, type \texttt{math-insert root}. This generates a root symbol with an extra box above the root sign. Use Up and Down to move between the two boxes. You can also use the key binding \texttt{M-m-r}.

### 5.1.8 Altering spacing

You may want to create blank spaces that differs from the standard spacing that \LaTeX provides. We don’t recommend this as a matter of course, since the whole
idea of WYSIWYM is that you don’t think about the typesetting, but the content. However, there are situations where you will want to add spaces. The first thing to do is to type C-Space. This generates a small space, and shows a small marker on the screen within LyX: $ab$. The next trick is to change that space to different sizes. Before you move the cursor, after typing C-Space, if you hit Space again, you will change the size of the space, through a number of variable sizes. The last ones in the list are red, and are a negative space. For example: $a \ b$, or $ab$. You can also insert these spaces via the math panel.

5.1.9 Math functions

The math panel contains a number of “functions”, such as sin, lim, etc. (you can type them in a formula by typing \sin etc). Standard mathematical practice is that functions which are names, like sin, should not be italicized. Entering just the letters sin within Mathed will give italics, of course, so these special macros are available. They do more to the final output than just change the typeface, however. For example, the expression $\sin t$ will typeset with a little extra space between the n and the t. For words which are more sophisticated mathematical objects, like lim, the macro changes the way that subscripts are placed, depending on whether the math-inset is inlined or displayed: $\lim_{x \to 0} f(x) = L$ versus $\lim_{x \to 0} f(x) = L$.

These two expressions were typed the same way, but using the macro \lim alters the appearance (actually, it is the inlined version that is altered, to improve linespacing).

5.1.10 Accents

In a formula you can insert accented characters in the same way as in text mode. This may depend on your keyboard, or the bindings file you use. You can also use \TeX macro equivalents, as macros. That is, you can enter \hat a to get the same effect if your keyboard does not have accents enabled. This is entered by typing “\hat a” in Mathed. These are the equivalences between the text names and the macro names for the various accents:
5.1 Basic Math Editing

<table>
<thead>
<tr>
<th>text</th>
<th>math</th>
<th>example</th>
</tr>
</thead>
<tbody>
<tr>
<td>circumflex</td>
<td>hat</td>
<td>(\hat{a})</td>
</tr>
<tr>
<td>grave</td>
<td>grave</td>
<td>(\grave{a})</td>
</tr>
<tr>
<td>acute</td>
<td>acute</td>
<td>(\acute{a})</td>
</tr>
<tr>
<td>umlaut</td>
<td>ddot</td>
<td>(\ddot{a})</td>
</tr>
<tr>
<td>tilde</td>
<td>tilde</td>
<td>(\tilde{a})</td>
</tr>
<tr>
<td>dot</td>
<td>dot</td>
<td>(\dot{a})</td>
</tr>
<tr>
<td>breve</td>
<td>breve</td>
<td>(\breve{a})</td>
</tr>
<tr>
<td>caron</td>
<td>check</td>
<td>(\check{a})</td>
</tr>
<tr>
<td>macron</td>
<td>bar</td>
<td>(\bar{a})</td>
</tr>
<tr>
<td>—</td>
<td>vec</td>
<td>(\vec{a})</td>
</tr>
</tbody>
</table>

Finally, you can choose one of these accents by selecting an item from the Decorations symbol set in the math panel; this will apply to any selection you have made within a formula too.

5.1.11 The math editor for \LaTeX users

Editing mathematical expressions in \LaTeX{} can be done in one of two ways. You can use the native \LaTeX{} support for rendering the formulae in a WYSIWYM fashion. \LaTeX{} users might like to be able to use the keyboard to enter things like $\alpha$ (this gets, in ordinary \TeX{}, an \(\alpha\) in the final document), believing that it is faster than chasing around menus for a symbol. Here’s a testimonial of one of those old \LaTeX{} users, David Johnson:

I was finally convinced that the math editor was the way to go when I found that, with a few modifications, I could use it the same way I was accustomed to writing \TeX{}. As an example, I created this \(\alpha\) by typing the following keys: First type M-c m to enter math-mode, then type \texttt{ \alpha }, then \texttt{ Space} and \texttt{ Esc}. As soon as I typed that \texttt{Space} the \(\alpha\) was right there on the screen.

The M-c m sequence inserts a formula (you may also use C-m or M-m m), the \texttt{ \alpha } is of course the standard \TeX{} command for a Greek alpha letter, and the \texttt{ Esc} leaves the formula. Some of the advantages of this approach are:

- You have immediate visual feedback to be sure your \TeX{} was correct
- You have the real mathematical expression on the screen, correctly displayed, to make sure your mathematics is correct (correctly written, at least)
- All the new \LaTeX{} fuss with special environments and such are taken care of by \LaTeX{}, not you
- You won’t have to chase through the code trying to find that missing $ or extra \{ any more

75
• If you don’t remember the \LaTeX name of a particular symbol, like $\wp$, you can find it in the dialogs

5.2 Brackets and decorations

There are several brackets available through \LaTeX. For most purposes, using just the keys `{}`()[{}<> should suffice, but the effect, especially if you want to surround a large structure, such as a matrix or a fraction, or if you have several layers of brackets, is better using the math panel’s Delimiter dialog [see sec. 5.1.6]. For example, that’s how you would construct the brackets around a standard matrix such as:

\[
\begin{bmatrix}
1 & 2 \\
3 & 4
\end{bmatrix},
\]

and to make it easier to see the layers of parentheses of an abomination such as:

\[
\frac{1}{1 + \left( \frac{1}{1 + \left( \frac{1}{1 + x} \right)} \right)}
\]
or:

\[
f(g(h(k(l(x)))))
\]

The parentheses, and other brackets, from that menu will automatically re-size to accommodate the size of what is inside (This is done in straight \LaTeX by \texttt{\left( blah \right)}).

It is very easy to construct the braces you want to use. Click on the brace you want on the left side with the left mouse button, the right side with the right button, and place them in the document by clicking on the button. If you want one side to not have a bracket, use the blank button. It will appear in \LaTeX with a dotted line, but nothing will print.

If you decide after the fact to place parentheses (or other math structure, like a square root, or other decoration) around some math structure, you can do that by highlighting (selecting) the structure that is to go inside the parentheses (that is done by holding the \texttt{Shift} key down and moving the cursor with the arrow keys, or selecting with the mouse). Then, choose the appropriate brackets for left and right, and click on \texttt{Apply}. The parentheses will be drawn around the selected structure.

If you’re trying to enter a \LaTeX \texttt{\{ for grouping, you should read 5.3.

5.3 Grouping

You may need to group a set of symbols. In \LaTeX, for example, the typesetting of \texttt{\{x\}y\}z is different from \texttt{x\{y\}z}:

\[
x^y z \text{ differs from } x^g z
\]
However, trying to type the } in LYX gives an actual closing brace in the output. To create this grouping, you need to use the key sequence \{ then type space. Inside LYX, you will see red braces indicating the grouping. The example directly above shows how this works.

5.4 Arrays and Multi-line Equations

Arrays, such as matrices, are easily entered in LYX. In the Math Panel there is a matrix button, which will open a dialog for you to choose the number of rows/columns. Here is an example:

\begin{pmatrix}
1 & 2 & 3 \\
4 & 5 & 6 \\
7 & 8 & 9
\end{pmatrix}.

The parentheses aren’t automatic, but you can add them as usual. Remember that you can add this after the fact, by highlighting the matrix inside Mathed (Position the mouse on one side of the matrix, hold the Shift key down, and hit the appropriate arrow key to move the cursor across the matrix). You can, when you construct the matrix, decide whether the columns (or some of them) will be left-, right-, or center-justified. The specification is ccc by default. Each letter corresponds to the relevant column. For example, lcr means that the first column will be left-justified, the second will be centered, and the third column will be right-justified. It will look like this:

\begin{tabular}{ccc}
this & this column & this column \\

has left alignment & center alignment & has right.
\end{tabular}

You can add more rows to an existing matrix by hitting C-Enter while in the matrix, and you can add columns, or delete either, via the Edit menu and Edit Rows&Cols menus.

There are numerous other arrays used in \LaTeX{} math-mode, particularly with the AMS-\LaTeX{} packages included, such as \texttt{\textbackslash cases} and commutative diagrams. Not all of these are supported in LYX but some are, see Insert Math.

Multi-line equations are very easy to construct in LYX. A formula will automatically switch to an eqnarray format (\LaTeX{}’s multi-line displayed equation format) if you hit C-Enter. The best way to do this, if you decide you want a multi-line displayed equation, is to insert a new line (with C-Enter) immediately. Each line then has three regions, left, center, and right, which you can move through using either the arrow keys, the mouse, or the Tab key. Here is an example:

\begin{align*}
3 &= 1 + 2 \\
4 + 5 &= 9.
\end{align*}

You can also turn an existing displayed formula into a multi-line formula by hitting C-Enter while the cursor is anywhere on the original formula. However, LYX will not
try to decide where to break the formula up into three parts, but places everything in the left side of the line. To change the alignment points of the equation, place the cursor where you want to start the middle part of the line, and hit C-Tab. It then puts everything to the right of the cursor in the middle region of the equation (which, by the way, is not typeset by \TeX{} in display-math size, so you should not put large expressions like fractions there). Move to where you want the right side of the line to begin, and hit C-Tab again. The “extra” insertion points in the line will disappear.

5.5 Equation Numbering and Labels

Equation numbering is very easy in \LaTeX{}. All it takes to change a displayed equation like:

\[ 1 + 2 = 3 \]

into the numbered equation:

\[ 1 + 2 = 3 \quad (5.1) \]

is to go to the Insert menu, and select the Label... option. This opens a dialog in which you must enter some string as the label. There is no need to call it by a specific number, since \TeX{} will take care of re-numbering the equation. Labels will not appear as such on the final output. \TeX{} will insert appropriate numbers for the equations. The labels are used internally for cross-referencing. You can turn on numbering without a specific label with the menu option Edit Math Toggle numbering while the cursor is in the equation, such as:

\[ 1 + 1 = 2. \quad (5.2) \]

You can toggle it on or off with this menu item. You can reference a labelled (not just numbered) equation, (cf. (5.1)) by using the Cross-Reference dialog, which you open using Insert Cross-Reference...

For numbered (or labelled) multi-line formulas, the default is that all lines are numbered separately. Once you attach a label to make the equation numbered, all subsequent lines receive a label of \#. That label can be changed to another so that you can refer to that line, like (5.4) below.

\[
\begin{align*}
1 &= 3 - 2 \\
2 &= 4 - 2 \\
4 &\leq 7.
\end{align*}
\quad (5.3) \quad (5.4) \quad (5.5)
\]

You can turn off numbering of a specific line with Edit Math Toggle numbering of line while the cursor is on that line of a multi-line numbered equation. This also toggles. For example:

\[
\begin{align*}
1 &= 4 - 3 \\
2 &= 7 - 5
\end{align*}
\quad (5.6) \quad (5.7)
\]
5.6 User defined macros in math mode

\[ 1 = e^{2\pi i} \]
\[ 16 \equiv 2 \pmod{7} \quad (5.8) \]

Note that the first equation in this set (5.6) is labelled, the next is numbered but unlabelled, the third is unnumbered, and the last (5.8) is again labelled.

5.6 User defined macros in math mode

\LaTeX{} allows the user to define macros for use in math mode. A macro definition box appears on screen as purple box with the name of the macro in blue (math color). It contains two cells initially marked empty by blue rectangles that can be edited as if it were ordinary math. Just try it: The contents of the first cell will be used when the macro definition is written during export as \LaTeX{}. The contents of the second cell, however, will be used for drawing the macro’s expansion on screen. In the common case where both export and drawing use the same representation, the second cell can be left empty and \LaTeX{} will use the contents of the first cell will be used for export and drawing automatically.

Now, to use this macro in other math boxes just type the name in \TeX{} mode, in this case \texttt{\textbackslash macro}, and it will be automatically expanded: \( c = a + b \). As you can verify, the cursor can’t go inside the macro, the whole macro is like a single character, and the \TeX{} generated code of this expression is \( c = \texttt{\textbackslash macro} \).

However the cursor could go inside of some kind of macros, those that have arguments. In a macro definition box an argument looks like a \# followed by the argument number:

Once expanded, this macro includes the usual empty rectangle to indicate that you can insert there whatever you want: \texttt{\textbackslash macrowarg = 2+\sqrt{x}}. Example: \( b = 2 + \sqrt{x - 2} \).

When exported to \LaTeX{}, a macro definition will produce the command \texttt{\newcommand{\macrowarg}[1] {2+\sqrt{#1}}}.

5.6.1 How to create macros

To create a macro definition box use this syntax in the minibuffer:\footnote{Macro names mustn’t contain numbers!}

\texttt{math-macro \textless macro name\textgreater \ [number of arguments]}

For example, \texttt{\textbackslash macro} was created with “\texttt{\textbackslash math-macro \textbackslash macro}”, and \texttt{\macrowarg} was created with “\texttt{\textbackslash math-macro \textbackslash macrowarg 1}”.

To insert an argument mark (only inside a macro definition box) simply type \texttt{\#<number>}, or use \texttt{math-macro-arg <number>}

The argument mark in \texttt{\macrowarg} was introduced with “\texttt{\textbackslash math-macro-arg 1}”.

You can use no more than 9 arguments, numbered from 1 to 9. An argument can be repeated inside the macro definition box, but of course can be edited only once.
5 Mathematical Formulae

5.6.2 How to navigate in macros

With the arrow keys: Opening a macro from the left side will put the cursor in the first argument, to move to the second argument use the TAB key. Remember that pressing the Space bar will get the cursor out and at the right side of the macro.

With the mouse: As usual, click on the desired argument box. Sometimes this fails if the box is empty or too small.

Currently it is only possible to define command macros, but not environment macros.

5.7 Fine-Tuning

5.7.1 Typefaces

You can use various typefaces in a formula. The standard font for text is italic, text, but for numbers the standard is Roman. To set a font in a formula, choose it from the math panel, or by entering the \textsc{LaTeX} command for it directly, as follows:

<table>
<thead>
<tr>
<th>Font</th>
<th>\textsc{LaTeX} Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roman</td>
<td>\texttt{mathrm}</td>
</tr>
<tr>
<td>Bold</td>
<td>\texttt{mathbf}</td>
</tr>
<tr>
<td>Italic</td>
<td>\texttt{mathit}</td>
</tr>
<tr>
<td>Typewriter</td>
<td>\texttt{mathtt}</td>
</tr>
<tr>
<td>BLACKBOARD</td>
<td>\texttt{mathbb}</td>
</tr>
<tr>
<td>Fraktur</td>
<td>\texttt{mathfrak}</td>
</tr>
<tr>
<td>CALLIGRAPHIC</td>
<td>\texttt{mathcal}</td>
</tr>
<tr>
<td>SansSerif</td>
<td>\texttt{mathsf}</td>
</tr>
</tbody>
</table>

\textsc{LaTeX}'s math mode does not support all characters in all fonts, and only letters will be supported with these font styles; some only support capital letters.

For any of these fonts, you have to be careful how you enter the text. If there is text to the right of the entry point, the font reverts to that style after one character. To be able to type a string in a particular font, make sure there is a protected-space to the right of the cursor. Also, entering a protected-space will revert subsequent text to standard font. The font styles are nestable, as \textsc{LaTeX} does. This can be a little confusing, as selecting a different font on a selection will not change the selection, but insert a new nested level with the new typeface.

It is possible (in AMS-\textsc{LaTeX}) to embolden (not italicize) numbers and special symbols. However, \textsc{LyX} does not yet support this in WYSIWYM manner. It will print correctly, though. To get emboldened symbols, for example a bold \(\alpha\), enter \texttt{\textbf{boldsymbol}{\alpha}} in Mathed. The closing brace appears (in red) automatically when you type the opening brace. This works for all symbols, as well as numbers.

A number of other options are available as well, via Insert>Math>Font Change.
5.7.2 Math Text Mode

Typefaces are useful for entering variable names in some given font, but certainly not for anything else, and in particular not text. For typing longer pieces of text, use math text mode, which is obtained by typing `M-m m` while already in math mode. (The same command will get out of math text mode, too.) Math text mode appears on the screen in black instead of blue. You cannot enter punctuation or font changes in your text, but it works for simple text. Here’s an example:

\[ f(x) = \begin{cases} x & \text{if I say so} \\ -x & \text{otherwise} \end{cases} \]

5.7.3 Font Sizes

There are four (relative) font sizes (or “styles”) used in math-mode, which are automatically chosen in most situations. These are called `textstyle`, `displaystyle`, `scriptstyle`, and `scriptscriptstyle`. For most characters, `textstyle` and `displaystyle` are actually the same size, but fractions, superscripts and subscripts, and certain other effects, are set larger or placed differently in `displaystyle`. Except for some operators, which re-size themselves to accommodate various situations, all text will be set in these various sizes as \( \LaTeX \) thinks is appropriate. These choices can be over-ridden by using the `math-size` function in the minibuffer. For example, you can set \( \frac{1}{2} \) normally (`textstyle`), or you can make it larger, which also changes the line-spacing, by entering `math-size displaystyle` in the minibuffer while the cursor is in the main line of the math-inset, \( \frac{1}{2} \). Careful, though, if the cursor is on the denominator of that fraction, only the numerator will be enlarged, e.g. \( \frac{1}{2}! \) This reflects a \( \LaTeX \) “unintended feature”, not a \( \text{\LaTeX} \) one. These font-size changes are not as apparent in \( \text{\LaTeX} \) as they are in the output. Here are some text in the various styles: `displaystyle`, `textstyle`, `scriptstyle`, `scriptscriptstyle`.

All these math-mode font sizes are relative, that is, if the whole math inset and surrounding text are set in a particular size, all these sizes will be adjusted. Similarly, if the base font size of the document is changed, all fonts will be adjusted to correspond.

Here is a paragraph in “largest” font, with symbols:

\( \alpha \).

This applies to math fonts in titles, etc. as well.

\[ \text{\textbullet} \]

2Moreover, math text mode outputs its contents inside a `\extrm{}`, whereas and `\mbox` (or AMS-\( \LaTeX \)'s `\text`) might have been a better choice.

3That is, a bug.
5 Mathematical Formulae

5.8 AMS-\LaTeX

The American Mathematical Society (AMS) provide a \LaTeX packages that are in common use. \LaTeX includes some support for these packages.

5.8.1 Enabling AMS-Support

In the Document > Settings dialog there is a checkbox, Use AMS Math. If selected, this will include the AMS-package in the document, and make the facilities available.

5.8.2 AMS-Symbols

The AMS-\LaTeX packages add support for some mathematical symbols that are not accessible from plain \LaTeX (or \LaTeX), but are fairly common in mathematical typesetting, such as the old-German Fraktur font and the stylized “blackboard bold” fonts commonly used to denote the real or complex numbers, or the integers. Once activated, all AMS-\LaTeX symbols and environments are available. You will run into trouble if you include these packages from the preamble, since \LaTeX now defines a few of the macros used in these packages on its own. The AMS-layouts include these packages automatically.

5.8.3 AMS-Formula Types

AMS-\LaTeX provides a selection of different formula types. \LaTeX allows you to choose between align, alignat, flalign, gather, and multiline. Refer to the AMS-documentation for the differences between these formula types.
6 More Tools

6.1 Cross-References

Those of you reading this manual online will see a grey box with text in it, right before the beginning of this sentence. This is a Label. Properly speaking, it is one half of a cross-reference. The other half is the Reference proper, and it looks like this: 6.1. Again, those of you reading the manual online will see a gray box with text in it. Those reading printed versions, however, will see a number — in this case, the number of this section. There are also other varieties of cross-reference: for example, 83. This is the page number containing the location of the label. That’s what cross-references do: they let you reference other parts of your document. You don’t need to remember which section number was what anymore — I\TeX{} will do that for you! All you need to do is use a Label to mark a section, figure, table, formula, etc., and then refer to it via a Reference.

To insert a label, use Insert\LaTeX{} Label. A box will appear where you can enter your label. You can change the name of the label at a later time by simply clicking on the gray box and reopening the label dialog.

To insert a reference, select Insert\LaTeX{} Cross Reference. The Insert Cross-Reference dialog appears with a list of labels. Selecting a list item, then clicking OK inserts a reference into the text; changing the Reference type allows you to insert a page number or other reference variant instead.

Note that if you cut & paste text from another document that contains a Label or Reference, or if you delete a label in your text, I\TeX{} will complain:

\begin{verbatim}
LaTeX Warning: Reference ‘X’ on page Y undefined on input line Z
LaTeX Warning: There were undefined references
\end{verbatim}

You’ll also see two question marks in the output instead of the reference.

There are a few more comments we need to make about the Labels. They always print the number of the section heading closest to them. So — if you want to put a label on a Chapter, but a Section heading immediately follows it, you need to put the Label into the Chapter environment. It doesn’t matter where, and it will look weird on the I\TeX{} screen. However, you need to do this if you want to label the Chapter separately from the Section. The same goes for all other section headings.

Also, a Label only makes sense in numbered section headings and table and figure floats. Bare figures and tables aren’t numbered, so, like unnumbered section headings,
you can’t really use a Label on it.\footnote{Well, you \textit{can}, but only if you use the \texttt{Page number} reference. The regular \texttt{Reference} — the one that refers to a section/table/figure number — won’t work, because there’s no numbered thingy to refer to! You could also use bare Labels as page markers, then refer back to them using the \texttt{Page number} reference. Once again, the regular \texttt{Reference} won’t work very well. It will refer to something, but that something will typically be the number of the previous numbered section heading.} See sections 4.3.2.1, 4.4.5, and 5.5 for details on using a Label with figures, tables, and equations, respectively.

### 6.2 URLs (Uniform Resource Locators)

It is often desirable to include long “verbatim” items in a document such as Web site URLs, e-mail addresses, etc.; these things typically do not contain any spaces and are thus difficult to typeset properly. Such items will often fall on a line boundary if they cannot be split, resulting in an overfull or underfull line depending on the circumstances. You can use \texttt{Insert\textgreater URL} within \LaTeX{}X to enter a long URL and have it split gracefully (if necessary) along automatically determined boundaries.

At the point in the document where you want to enter the URL (or other address-like entity) simply select \texttt{Insert\textgreater URL}; a dialog will appear where you can enter the full URL (in the \texttt{Url} field). In its simplest usage, that’s all you need to do. Click on the following gray box to see how \LaTeX{}X’s homepage would be entered: \url{http://www.lyx.org}.

If you would like to associate some definite phrase with the URL, enter it into the \texttt{Name} field of the dialog; it will be typeset as plain text immediately before the URL. For example, I might say that you can find all things related to \LaTeX{} at CTAN \url{http://ctan.tug.org}. On the printed page, the last sentence ends as “all things related to \LaTeX{} at CTAN \url{http://ctan.tug.org}.”

[Author’s Note: somebody needs to document the \texttt{HTML Type} button]

### 6.3 Specifying Short Titles with Optional Arguments

Some section or chapter titles, such as this one, can get quite long. This can cause over-runs when there is limited horizontal space. For example, if the header of the page is set to show the current section title, a long title will over-run past the edges, and look awful.

\LaTeX{} allows you to specify an optional argument to the section commands that specifies a shorter version of the title\footnote{Important note: When you use the following characters: ‘\%’, ‘\#’, ‘\^’, you have to write them with a backslash before, e.g. “\#”. URLs mustn’t end with a backslash!}. This shorter version is used in the header and in the actual Table of Contents, avoiding the problem mentioned. \LaTeX{}X allows you to specify this optional argument by selecting \texttt{Insert\textgreater Short Title}. This will insert a box

\footnote{For those who don’t know \LaTeX{}, commands look like this: \texttt{\backslash command[optionalargument]{the content}}}
(labelled “opt”, which stands for “optional”) which you can use to enter the short title text. This also works for captions inside floats.

The title of this section is a good example of using this feature.

6.4 Branches

Sometimes you wish to be able to output to paper multiple versions of the same document. The most extreme version of this is, when you want to prepare a single document in two or more different languages, but as a single document file, with corresponding pieces of text adjacent in the file and on-screen. This can be achieved with branches.

First, you have to define the branches available within a particular document. This is done in the Document $\rightarrow$ Settings $\rightarrow$ Branches tab. You can also associate a background colour with each branch, e.g., red for the English language, blue for the German language branch. Then, you create a branch inset from the Insert $\rightarrow$ Branch menu item. The inset will contain the text that you want to be output when this branch is activated.

Activation or deactivation of a branch is done from the document settings menu. All insets belonging to deactivated branches will be automatically closed, those belonging to activated branches automatically opened.

Other possible applications of the Branches paradigm include a “teacher’s version” of a textbook containing the answers to questions, etc.

6.5 Previewing snippets of your document

\LaTeX{} allows you to generate previews of sections of your document on the fly so you can see how they’ll look in the final document without having to break your train of thought with View $\rightarrow$ DVl. If you’d like to see your math formulae typeset by \LaTeX{} then install the necessary software (see below) and select the Instant preview “On” pulldown item in the Tools $\rightarrow$ Preferences dialog. (It can be found in the Look and feel $\rightarrow$ Graphics pane in the Qt frontend and the Look & Feel $\rightarrow$ Misc tab in the XForms frontend.) Previews are generated when you load a document into \LaTeX{} and when you finish editing an inset. Previews of an already loaded document are not generated just by selecting the Instant preview check box.

\LaTeX{} will generate previews of math insets. It will also generate previews of include insets or “child documents” if you select the Show preview check box in the inset’s dialog. This latter is useful if you wish to generate a preview of a \LaTeX{} figure, for example. Coming in version 1.4 are previews of the external inset also.

To get previews working, you’ll need some additional software. First, you’ll need the preview.sty \LaTeX{} package. Find it on your local CTAN mirror at CTAN/support/preview-latex/. Thereafter, you’ll need the usual tools: latex, dvips and gs. Finally, you’ll obtain prettier results if you install pmncrop from the
6.6 Spacing, pagination and line breaks

6.6.1 Extra Horizontal Space

HFills are a special LyX feature for adding extra space in a uniform fashion. An HFill is actually a variable length space, whose length always equals the remaining space between the left and right margins. If there is more than one HFill on a line, they divide the available space equally between themselves.

Note: if an HFill is at the beginning of a line, and it’s not the first line in a paragraph, LyX ignores it. This prevents HFills from accidentally being wrapped onto a new line.

HFills can be inserted with Insert→Special Formatting→Horizontal Fill. Here a few examples what you can do with them:

<table>
<thead>
<tr>
<th>This is on the left side</th>
<th>This is on the right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Middle</td>
</tr>
<tr>
<td>Left</td>
<td>1/3 Left</td>
</tr>
<tr>
<td>Left</td>
<td>Right</td>
</tr>
</tbody>
</table>

That was an example in the Quote environment. Here: :is one in a standard paragraph. It may or may not be apparent in the printed text, but it is sitting in-between the two “:”.

Remember that we said that an HFill always fills the remaining space between the margins? There may be more than one set of margins on a line. Here’s an example with the List environment.

one two :three four five six

The “:” marks the beginning of the item. (There is actually a “hidden” HFill inside of the label of the List environment; it’s put at the end of the label automatically.) HFills work similarly in other “multi-margin” situations, like two-column mode.

6.6.2 Extra Vertical Space

To add extra vertical space above or below a paragraph, use Edit→Paragraph Settings to open the Paragraph Settings dialog.

We will not provide an example of a VFill, as it would waste paper. They work the same as any other type of filler, including HFills: they fill the remaining vertical space on a page with blank space. If there are several VFills on a page, they divide the remaining vertical space equally between themselves. You can therefore use VFills to center text on a page, or even place text 2/3 down a page, or 1/4, and so on.

Note that for paragraphs at the top/bottom of a page, the extra space is only added if you have also checked the option Edit→Paragraph Settings→Spacing→Keep space.
6.6.3 Changing Paragraph Alignment

You can also change the paragraph alignment with the Edit > Paragraph Settings dialog. There are four possibilities:

- **Justified**
- **Left**
- **Right**
- **Center**

The default in most cases is justified alignment, in which the inter-word spacing is variable and each line of a paragraph fills the region between the left and right margins. The other three alignments should be self-explanatory, and look like this:

This paragraph is right aligned,

this one is centered,

this one is left aligned.

In some paragraph environments, the default is something other than justified alignment.

6.6.4 Forcing Page Breaks

If you don’t like the way \LaTeX{} does the page breaks in your document, you can force a pagebreak where you want one. In general, this will not be necessary because \LaTeX{} is good at pagebreaking, as was already mentioned in section 3.7.4.

So in general there is no need to use the option described below, and we recommend not using it until the text is finished, and until you have checked in the preview to see if you really have to change the pagebreaking. You can force a pagebreak above or below a paragraph in the Edit > Paragraph Settings dialog by selecting the checkboxes to add a pagebreak above or below the paragraph.

You might try to use a pagebreak to ensure that a figure or table appears at the top of a page. This is, of course, the wrong way to do it. \LyX{} gives you a way of automatically ensuring that your figures and tables appear at the top of a page [or the bottom, or on their own page] without having to worry about what precedes or follows your figure or table. See sections 4.3 and 4.4 and read about Floats to learn more.
6.6.5 Blanks/Spaces

A blank is a blank? Not in good typography. While you might be used to press the space key anytime you want to separate two words in ordinary word processors, \LaTeXX offers you more spaces: Spaces of different width and spaces which can or cannot be broken at the end of a line. The following sections will show you some examples where those spaces are useful.

6.6.5.1 Inter-word Space

Some languages (e.g., English) have the typographical convention to add extra space after an end-of-sentence punctuation mark, and \LaTeXX honors those conventions (see section 3.7.2.1). Sometimes, you want a normal space nevertheless. In this case, insert one with Insert $\mathbin{\text{	extgreater}}$ Special Formatting $\mathbin{\text{	extgreater}}$ Inter-word Space or with C-M-Space.

6.6.5.2 Protected Space

The protected space: It is used to tell \LaTeXX (and \TeX) not to break the line at that point. This may be necessary to avoid unlucky linebreaks, like in:

A good documentation should weight no more than 1 kg.

Obviously, it would be a good thing to put a protected space between “1” and “kg”. A protected space is set with Insert $\mathbin{\text{	extgreater}}$ Special Formatting $\mathbin{\text{	extgreater}}$ Protected Space or with C-Space.

6.6.5.3 Thin Space

A “thin space” is a blank which has half the size of a normal space (and it is also “protected”). The typographical conventions in a lot of languages propose the use of thin spaces in cases where normal spaces would be too wide, for instance inside abbreviations:

D. E. Knuth has developped our beloved typesetting program, i.e. \TeX.

You can insert a thin space with Insert $\mathbin{\text{	extgreater}}$ Special Formatting $\mathbin{\text{	extgreater}}$ Thin Space or with C-S-Space.

6.6.5.4 More Spaces

Apart from the ones described, there are still some more spaces. Although \LaTeXX supports them natively, they can only be reached via the minibuffer. To get them, just type space-insert $\langle$command$\rangle$ into the minibuffer, where $\langle$command$\rangle$ is one of the following:
6.6.6 Line breaking

You can force line breaks within a paragraph by selecting Insert $\rightarrow$ Special Formatting $\rightarrow$ Linebreak or with C-Return. You should, however, not use this to correct `\LaTeX`'s linebreaking, as `\LaTeX` is very good at linebreaking... (see section 6.6.4). There are, however, a number of situations where it is necessary to actively set a linebreak, e.g. in a poem or for an Address (see sections 3.3.5.1, 3.3.5.2 and 3.3.7.2).

6.7 Spellchecking

`\LaTeX` itself has no built-in spellchecker. Rather it uses the external `ispell` program as a backend or the newer and generally better `aspell`. This section assumes you have already installed and set up one of these programs.

The spellchecker can be started with the menu entry Tools $\rightarrow$ Spellchecker. Checking will start just after the current cursor position. A dialog window will appear showing any incorrect (or unknown) word found, allowing you to edit and replace it in a second line. Whenever an unknown word is found, the word is highlighted and the view in your text buffer is updated to make the word visible. In the Spellchecker dialog, there is also a box showing suggestions for a correction, if any could be found. Clicking on one of the corrections will copy the near miss into the replace input field (double-click to invoke replace).

6.7.1 Spellchecker Options

The following options can be set in the Tools $\rightarrow$ Preferences dialog.

6.7.1.1 Dictionary

By default, the dictionary file to use is determined by the language of the text you’re checking, which is set in the Document $\rightarrow$ Settings dialog. If you do not have a dictionary for the document language, the spellchecker will not work. In this case, you can specify another dictionary file in the dialog by specifying a different “alternative language”.

<table>
<thead>
<tr>
<th>command</th>
<th>width</th>
<th>protected?</th>
</tr>
</thead>
<tbody>
<tr>
<td>normal</td>
<td>1/3 em</td>
<td>no</td>
</tr>
<tr>
<td>protected</td>
<td>1/3 em</td>
<td>yes</td>
</tr>
<tr>
<td>thin</td>
<td>1/6 em</td>
<td>yes</td>
</tr>
<tr>
<td>enspace</td>
<td>0.5 em</td>
<td>yes</td>
</tr>
<tr>
<td>enskip</td>
<td>0.5 em</td>
<td>no</td>
</tr>
<tr>
<td>quad</td>
<td>1 em</td>
<td>no</td>
</tr>
<tr>
<td>qquad</td>
<td>2 em</td>
<td>no</td>
</tr>
<tr>
<td>negthinspace</td>
<td>-1/6 em</td>
<td>yes</td>
</tr>
</tbody>
</table>
If you’re using ispell, you may need to make a link from say deutsch.(aff|hash) to german.(aff|hash) or whatever applies for your language. This is because these ispell files normally have the native language name (“deutsch”) whereas ispell, when started from LyX, searches for the English version of the name used with the \LaTeX babel package (“german”).

You may also have problems the font encoding is not correct for that dictionary. If you use a language with latin1 encoding and set the Encoding option in the Document > Settings dialog to latin1 (or other than default), you must have this option in your language dictionary as well. If your dictionary doesn’t support the Encoding you chose, you’ll have an error like this on stderr:

```
ispell: unrecognized formatter type 'latin1'
```

The spellchecker gives you an error that it couldn’t start the ispell process and that you probably have some problems with your dictionary file.

There are four solutions to this problem. The easiest is to try the Use Input Encoding option. If that does not help, you can set Encoding to default when calling the spellchecker (which is probably annoying). The third is to add the latin1 option to your dictionary <language>.aff file and recompile the dictionary (which probably isn’t easy if you installed the whole stuff with some distribution and don’t have the language directory of the ispell sources). Read the ispell documentation for this task! The fourth is to send a message to your package-maintainer, or better yet to the maintainer of the dictionary file in question and ask him to solve your problem.

### 6.7.1.2 Personal dictionary

If you want to use a different file from the spellchecker’s default choice as your personal dictionary, you can set this in the dialog. Specifying a filename which does not already exist will result in an error message on stderr which you can ignore (ispell will create the file when you finish checking your spelling).

### 6.7.1.3 Further Options

The Spellchecker Options dialog has some additional options which are self-explanatory:

- **Accept compound words**
  Prevent the spellchecker from complaining about compounded words like "passthrough".

- **Escape characters**
  Allows you to add nonstandard characters to what the spellchecker considers words, e.g. German umlauts. This should not normally be needed.

### 6.7.2 Limitations

Some users have expressed a wish to be able to globally change the spelling of a particular word, rather than having to change the spelling separately for each occurrence
of the word. Per-document word lists would also be useful. Neither of these features are present as of this writing.

Unless you’re using the `pspell` spellchecker, LyX cannot correctly spellcheck documents containing multiple languages. This, however, work with `pspell`, assuming you have marked the different languages appropriately.

## 6.8 International Support

This section describes how to use LyX with any language you want. LyX comes with a default configuration which supports the English language on a U.S.-style keyboard, with a standard U.S. paper size and the spellchecker set to U.S. English. You can change any or all of these settings as desired, and you can make the changes apply to the current session only, or use them as your new default configuration.

If you have a keyboard suited to the language you are using (for example, a German keyboard for writing in German), and you have correctly configured your X environment, all you need to do for LyX is tell it your language, the character encoding, and desired paper size. Refer to 6.8.1 for more information.

If, however, you have a U.S.-style keyboard and want to write in a different language than English, you can use an alternate keymap. For example, if you have a U.S.-style keyboard but want to write in Italian, you can configure LyX to use an Italian keymap. Refer to 6.8.2 for details.

Finally, you may just want to change a few key mappings or create an entirely different keymap (for Vulcan, for instance). You may, for example, normally write in Italian on a U.S. keyboard but want to include an occasional quotation in German. In such a case, you can write your own keyboard mapping or modify an existing one to support the characters you want.

The details of how to customize LyX to your own language are way beyond the scope of this manual. You can not only alter the keyboard layout, you can also change the names of the menus buttons, etc., to reflect your language. If you want to learn more about writing keymap files and tailoring LyX to your native tongue, please see the *Customization* manual for details.

### 6.8.1 Language Options

The Document → Settings dialog lets you set the language and character encoding for your language.

Choose your language by clicking on the arrow in the Language combobox of the Document → Settings dialog. The default is U.S. English. Scroll to find the language you want and then click on your choice. The language name appears in the window.\footnote{In \LaTeX{} terms, selecting a language other than default adds Babel support. If you do not have Babel installed, refer to the different \LaTeX{} distributions for it.}
The Encoding box lets you choose the character encoding map you want to use. The default is the Latin1 encoding, which includes the characters required by the various Western European languages.

### 6.8.2 Keyboard mapping configuration

The preferences dialog allows you to choose up to two keyboard mappings. This allows you to choose the keymap of your choice for your U.S.-style keyboard. You can choose primary and secondary keyboard languages and then select which one you want to use.

### 6.8.3 Character Tables

Table 6.1 shows the Latin1 character set. You should be able to enter the characters in the first eight columns directly from the keyboard.

There are a few things you need to know about this table. This manual is set up — by hand, mind you — to print all of these characters. That ain’t the default. Nowhere near, in fact. Here are some of the details you’ll need to bear in mind when using characters from the Latin1 character set:

- The characters at entries A2, A4, A5, A6 and AD — the cent, the yen, the generic-currency-symbol, the broken vertical bar and the short dash are just plain missing in the default encodings. We don’t know where they are or why this is the case.

- Even if you’ve selected latin1 in the Document > Settings dialog, users who have only the T1-fonts for \LaTeX{} [or who have the T1-fonts but aren’t using them] will still miss a few characters: D0, F0, DE, FE, AB, and BB — the uppercase and lowercase eth and thorn, and the french quotes won’t show up.

- Users of T1-fonts can, however, get the french quotes [characters AB and BB] if they include the either the package umlaute.sty or german.sty in their documents.\footnote{This only holds when you want to input these quotes by yourself. The automatic quote feature described in Section 3.7.2.2, will generate automatically \LaTeX{} code adapted to available fonts and packages.}

The following is a full list of all of the accented characters LyX can display directly. It includes not only the accented characters from the previous table, but also the characters from ISO8859--2 through 4.

- From ISO8859--1:

```
- Å Åä ÅÉ ÅÈ ÅÊ ÅÖ ÅÙ 
- Åé Åè Åë Åê Åë Åô Åû 
```

\footnote{This only holds when you want to input these quotes by yourself. The automatic quote feature described in Section 3.7.2.2, will generate automatically \LaTeX{} code adapted to available fonts and packages.}
### Table 6.1: The latin1 character set

<table>
<thead>
<tr>
<th></th>
<th>00</th>
<th>10</th>
<th>20</th>
<th>30</th>
<th>40</th>
<th>50</th>
<th>60</th>
<th>70</th>
<th>80</th>
<th>90</th>
<th>A0</th>
<th>B0</th>
<th>C0</th>
<th>D0</th>
<th>E0</th>
<th>F0</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>0</td>
<td>@</td>
<td>P</td>
<td>'</td>
<td>p</td>
<td>.</td>
<td>A</td>
<td>D</td>
<td>ä</td>
<td>ã</td>
<td>ö</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>!</td>
<td>A</td>
<td>Q</td>
<td>a</td>
<td>q</td>
<td>i</td>
<td>±</td>
<td>A</td>
<td>N</td>
<td>á</td>
<td>ñ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>&quot;</td>
<td>2</td>
<td>B</td>
<td>R</td>
<td>b</td>
<td>r</td>
<td>ç</td>
<td>²</td>
<td>A</td>
<td>O</td>
<td>á</td>
<td>ò</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>#</td>
<td>3</td>
<td>C</td>
<td>S</td>
<td>c</td>
<td>s</td>
<td>£</td>
<td>³</td>
<td>A</td>
<td>O</td>
<td>à</td>
<td>ó</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>$</td>
<td>4</td>
<td>D</td>
<td>T</td>
<td>d</td>
<td>t</td>
<td>€</td>
<td>ø</td>
<td>A</td>
<td>O</td>
<td>à</td>
<td>ó</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05</td>
<td>%</td>
<td>5</td>
<td>E</td>
<td>U</td>
<td>e</td>
<td>u</td>
<td>¥</td>
<td>¼</td>
<td>A</td>
<td>O</td>
<td>á</td>
<td>ó</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06</td>
<td>&amp;</td>
<td>6</td>
<td>F</td>
<td>V</td>
<td>f</td>
<td>v</td>
<td>¡</td>
<td>½</td>
<td>E</td>
<td>O</td>
<td>æ</td>
<td>ò</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>'</td>
<td>7</td>
<td>G</td>
<td>W</td>
<td>g</td>
<td>w</td>
<td>Š</td>
<td>ç</td>
<td>Æ</td>
<td>Ò</td>
<td>æ</td>
<td>ò</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>(</td>
<td>8</td>
<td>H</td>
<td>X</td>
<td>h</td>
<td>x</td>
<td>„</td>
<td>É</td>
<td>Õ</td>
<td>Ú</td>
<td>Ú</td>
<td>Ú</td>
<td>Ú</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09</td>
<td>)</td>
<td>9</td>
<td>I</td>
<td>Y</td>
<td>i</td>
<td>y</td>
<td>©</td>
<td>¹</td>
<td>E</td>
<td>U</td>
<td>é</td>
<td>û</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0A</td>
<td>*</td>
<td>:</td>
<td>J</td>
<td>Z</td>
<td>j</td>
<td>z</td>
<td>a</td>
<td>o</td>
<td>E</td>
<td>U</td>
<td>é</td>
<td>û</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0B</td>
<td>+</td>
<td>;</td>
<td>K</td>
<td>[</td>
<td>k</td>
<td></td>
<td></td>
<td>«</td>
<td>»</td>
<td>E</td>
<td>U</td>
<td>é</td>
<td>û</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0C</td>
<td>,</td>
<td>&lt;</td>
<td>L</td>
<td>\</td>
<td>l</td>
<td></td>
<td></td>
<td>¬</td>
<td>¼</td>
<td>I</td>
<td>U</td>
<td>i</td>
<td>û</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0D</td>
<td>-</td>
<td>=</td>
<td>M</td>
<td>]</td>
<td>m</td>
<td></td>
<td></td>
<td>½</td>
<td>I</td>
<td>Y</td>
<td>i</td>
<td>ý</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0E</td>
<td>.</td>
<td>&gt;</td>
<td>N</td>
<td>¤</td>
<td>n</td>
<td></td>
<td></td>
<td>®</td>
<td>¾</td>
<td>I</td>
<td>ß</td>
<td>i</td>
<td>þ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0F</td>
<td>/</td>
<td>?</td>
<td>O</td>
<td>_</td>
<td>o</td>
<td></td>
<td></td>
<td>-</td>
<td>Đ</td>
<td>I</td>
<td>ţ</td>
<td>ñ</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- `À É Ì Ò Ü â è i ò ù`
- `´ Á É Í Ó Ú á é í ó ú ù`
- `~ ´ Ñ Ô ã ñ ô`  
- `ÇÇ`
- `-`

- From ISO8859--2 through 4:
  - ŃHJhČGŠčgš
  - ŠZŠžŘĽČNřčnú
  - ÍiÜü
  - ŠštTRĽgũgNḵug
  - ÉéAÍOÜáůů
  - ÖÚôů

All the characters above are actively supported by TeX fonts. In addition TeX allows diacritical marks on almost all characters. Also make sure you’re using the T1

---

6. The dead macron in usually not needed, as you will use a non–dead key for this instead. For example, S-M-minus, or if .Xmodmap is correct, S-M-macron.

7. These characters might not look very nice on screen, but they will be just fine when run through LATEX and printed.
font-encoding and have the package `umlaute.sty` with the definition file `iso.def` installed.
7 Credits

The documentation is a collaborative effort between many different people (and we would encourage people to contribute!).

First, we need to give due credit to those who came before us. They gave us the base upon which the new manuals are built, and some continue to provide information:

- **Matthias Ettrich** wrote the original documentation, from which this manual is built, as well as the introduction to this manual [or the “LYX Manifesto,” as some of us call it].
- **Lars Gullik Bjønnes** wrote several minidocs, including some of the information about international support in LYX.
- **Ivan Schreter** also wrote a minidoc about international support, specifically about international keyboard maps and customization.
- **Pascal André** originally documented the LinuxDoc SGML interface.
- **Alejandro Aguilar Sierra** originally documented math mode and provided the entries for the math functions in Reference.lyx
- Special thanks to the LYX Team [1] for help and answers to questions.

Next, it’s time to give credit to the “LYX Documentation Team,” all of the people who helped rewrite the old documentation into the form it had after LYX version 0.10:

- **David Johnson:**
  - Contributor to the FAQ and the old “HowDoI-.lyx” [now defunct].
  - General editing assistance.
  - Documentation of:
    * math mode
    * tables
    * spellchecking

- **Rich Fields:**
  - Primary contributor to Reference.lyx
7 Credits

- Documentation of the basic \LaTeX{} interface in UserGuide.lyx

- **Paul Evans:**
  - Former maintainer of the FAQ and the old “HowDoI-\texttt{.lyx}” [now defunct].
  - Documentation of LinuxDoc in UserGuide.lyx

- **Paul Russel:**
  - Documentation of figures and imported graphics in UserGuide.lyx

- **John Raithel:**
  - Documentation of internationalization features in UserGuide.lyx

- **Robin Socha:**
  - Documentation of:
    * footnotes
    * margin notes
    * table of contents
    * cross-references

- **Amir Karger**
  - Primary contributor to Tutorial.lyx

- **Matthias Zenker:**
  - Documentation of
    * manual fine-tuning
    * using \TeX{} from within \LaTeX{}X

- **John Weiss:**
  - General organization and format of the documents.
  - Documentation of:
    * \LaTeX{}X setup
    * paragraph environments, document layout, nesting, typography notes, fonts
  - Also responsible for Introduction in Tutorial.lyx
  - Editor of the documents. [from 6/96-fall 1997]

After fall of 1997, the \LaTeX{}X Team as a whole took over maintenance of the documentation.
Bibliography

[1] The $\LaTeX$ Team: \textit{CREDITS}


[4] Kopka and Daly: \textit{A Guide to \LaTeX{} 2ε}

[5] Donald E. Knuth. \textit{The \TeX{}book}